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1. 2021

1.1 July

ReqIF requirements format (2021-07-22 10:56)

RIF/ReqIF (Requirements Interchange Format) is an XML file format suitable for lossless
exchange of requirements in any industry. The old way of transmitting requirements were
lossy like Office Documents, PDF or Spreadsheets, ReqIF offers solutions to keep the data
integrity through the supply-chain.

It is used to exchange requirements, along with its associated metadata, between software

tools from different vendors. ReqIF keeps the data integrity of requirements, attributes,

additional files (e.g. images) through the supply-chain. ReqIF format also defines a

workflow for transmitting the status of requirements between partners. Each object is

uniquely identified by GUID (globally unique identifier inside a RIF / ReqIF file), ensures

unique content across the data exchange processes.

The interchange standard

Main players of the automotive industry in Germany agreed to conform to the RIF/ReqIF

joint standard, initially developed by HIS Group, ProSTEP iViP, now maintained by OMG.

(Object Management Group)

History

In 2004, HIS (Herstellerinitiative Software) a consortium of German automotive manufac-
turers, defined a generic requirements interchange format called RIF.

The format was handed over in 2008 to [1]ProSTEP iViP e.V. for further maintenance. A
project group responsible for international standardization further developed the format
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and handed over a revised version to [2]Object Management Group (OMG) as "Request for
Comment" in 2010.

As the acronym RIF had an ambiguous meaning within the OMG, the new name ReqIF was
introduced to separate it from the W3C’s [3]Rule Interchange Format.

In April 2011, the version 1.0.1 of ReqIF was adopted by OMG as a formal specification
(OMG Document Number: formal/2011-04-02).

In October 2013, version 1.1 was published (OMG Document Number: formal/2013-10-01).
Changes are restricted to the text of the standard, the XML schema and underlying model
have not changed. Therefore, 1.1 and 1.0.1 .reqif files are equivalent.

In July 2016, version 1.2 was published (OMG Document Number: formal/2016-07-01). Like
with the previous versions, changes are restricted to the text of the standard, the XML
schema and underlying model have not changed. Therefore, 1.2, 1.1 and 1.0.1 .reqif files
are equivalent.

Source: [4]wikipedia.org

Naming conventions and structure of ReqIF files

The Prostep iViP published a guide how to exchange with ReqIF and an implementation
guide for ReqIF, where you can find detailed information how to use this file format and
also about the file structure, naming convention and interchange. To read about it, click on
the link:

[5]Prostep iViP - ReqIF Recommendation

We recommend to read the [6]chapter 2, to get an overview about the common use cases
of ReqIF file exchange. [7]Chapter 3 describes the custom attributes used in ReqIF, and
[8]chapter 4 specifies the workflow of the SRC process.

[9]Prostep iViP - ReqIF Implementation Guide
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For more technical details please look at the Prostep [10]Implementation Guide. We
recommend to study the [11]chapter 2.1-2.3 for an overview.

1. https://en.wikipedia.org/wiki/ProSTEP_iViP
2. https://en.wikipedia.org/wiki/Object_Management_Group
3. https://en.wikipedia.org/wiki/Rule_Interchange_Format
4. https://en.wikipedia.org/wiki/Requirements_Interchange_Format
5. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf
6. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf#page=8
7. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf#page=24
8. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf#page=29
9. https://www.prostep.org/fileadmin/downloads/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf
10. https://www.prostep.org/fileadmin/downloads/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf
11. https://www.prostep.org/fileadmin/downloads/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf#page=8

Install ReqEdit (2021-07-22 10:56)

System Requirements

Microsoft Windows x64
.Net 4.7.2 runtime package
MS EDGE browser or Chrome (for Compare Add-on HTML report)

Operating systems

OS VersionTested configurationLimitations

Windows 11 Pro x64 .Net 4.8

EDGE included

Windows 10 Pro x64 .Net 4.8 / 21H

EDGE installed by update

Windows 8.1 x64

EOL 2023-01-10 .Net 4.8

EDGE manually installed
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Windows 7 Enterprise x64

EOL 2020-01-14 .Net 4.8

EDGE installed manually

Windows Server 2022 Data Center x64 .Net 4.8

EDGE included

Windows Server 2019 Data Center x64 .Net 4.8

IE11 included on IE11 - HTML compare report, some features are missing

Windows Server 2016 Data Center x64 .Net 4.8

IE11 included on IE11 - HTML compare report, some features are missing

Windows Server 2012 R2 x64

EOL 2023-10-10 .Net 4.8

IE10 included

IE11 installed by update on IE11 - HTML compare report, some features are missing

Windows compatibiltiy of ReqEdit 2.17 (2021 Nov)

Installation
ReqEdit comes packaged into an installer that guides users through the install procedure.
It will unpack the files into a custom user directory.

Run the Installer

Window Installation

Run the provided installer executable and go through the steps, default install path is the
user profile folder in windows.
8



On the last step of the installer you can choose to activate the license. For that check the
checkbox.

Window Start Activation Setup

Licensing Models
After installation follow your model of licensing. More about licensing read [1]here.
1. https://documentation.reqteam.com/licensing-models/

Open ReqIF requirement files (2021-07-22 15:31)

ReqEdit is used to display contents of ReqIF requirement exchange files including attach-
ments and images in ReqIF Archive files.

These are the key features:

• ReqIF requirement objects

• hierarchy structure

• Internal UUIDS

• attribute types

• specification attributes
9
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• object attributes and relations

For experienced users the XML Editor add-on can display the source code of the ReqIF file.

Supported RIF/ReqIF file extensions: RIF contents (.xml .rif .zip) or ReqIF content (.reqif
.reqifz)

More about RIF and ReqIF files read [1]here.

Open file

Dashboard for ReqEdit

To open a file

• click on the Open Specification on the Dashboard or

• select File > Open on the main menu or

• press CTRL+O and then select the ReqIF file.
10



ReqEdit displaying an opened ReqIF file

All containing specification documents are displayed as tabs in the tab bar.

ReqEdit tab bar showing a ReqIF with three specifications

Compatible ReqIF files

If the file is not a standard ReqIF file but ReqEdit can import it, a popup notifies the user.
Import wizard starts and completes the steps to open file.

11



ReqEdit found an invalid ReqIF but asks the user for importing the file

Multi ReqIF Archives

If the opened document contains multiple ReqIF files (is an archive format .reqifz or .zip) a
popup notification allows the user to select the files to open.

ReqEdit showing document selector for .zip or .reqifz files (containing two or more ReqIF
files)
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In case of any ReqIF errors, ReqEdit identifies the errors. Use XML Editor Add-on to correct.

Error message shows ReqEdit detected an

invalid ReqIF source code

ReqIF file format

ReqEdit follows [2]ReqIF standard on all levels. It will display contents of ReqIF files from
structural to attribute definitions.

ReqIF format

Attribute Types
atomic data types: boolean, date, enumeration, int, float, string, xhtml

Attributes
uses the basic attribute type definitions with optional restrictions: min, max, length, can

13



be defined for objects and specifications also

Object types
collection of attribute types that are grouped together

Objects
uses a specific object type and has values for each attribute

Values
value objects for attributes of objects or specifications

Specification Types
a collection of object types and specification attributes

Specifications
uses a single specification type

Hierarchy
requirement object structure inside a specification

Relations
links between the objects

Documents

ReqIF requirements are grouped into specification documents, these are displayed in the
tab bar. Each opened ReqIF file will have its own random color to indicate that the files are
together.
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ReqEdit tab bar showing colored dots in front of specifications that are contained in a single
opened file

Hierarchy

Each specification document has its own object structure which is shown in the navigator
tab.

ReqEdit displaying an opened ReqIF file, navigator on the left side is highlighted

The navigator can be used to quickly jump to a specific section in the specification docu-
ment.

Numbering
Automatically generated for each ReqIF.ChapterName which are used as headlines. Depth
is determined by child objects.
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Objects

Each row in the main content area is an object that has a Main Content and additional
attributes. Objects are displayed as follows

ReqEdit displaying different types of requirement object states from top to bottom:
not changed (white), edited and saved (blue), new not saved (green), deleted (red), with
links (link icon, in, out, external)

Status indicator

First column of the grid is a frozen column, which means that the user will always see the
column, even if the document will be scrolled horizontally.

Displays the following states:

• unchanged – marked with white color

• edited – marked with light green

• edited and saved – marked with light blue
16



• links - marked with link icon

– internal links
– external links
∗ URI / OSLC
∗ Inward / Outward

• red - soft deleted (can be recovered)

More about Editing objects you can read [3]here.

Attachments

ReqEdit displaying attachment previews of an object, file icons and preview images

Double-click on the icon. The attached file will be opened by the installed applications on

the machine.

Attributes

17



Object attributes are displayed as columns inside the data grid. The default column layout
starts with Main Column then the rest of the object attributes defined in the specification.

By default all attributes are displayed in the specification as texts

Main Column

Displays the the main ReqIF attributes: ReqIF.ChapterName, ReqIF.Name, ReqIF.Text as a
single cell where

ReqIF.ChapterName - is displayed as Headline and will be auto numbered, displayed in the
navigator

ReqIF.Name - displayed in the content area as text

ReqIF.Text - displayed in the content area as text

The main column rendering can be customized in the Settings > Document menu

Attribute columns

All columns can be set hidden / visible by right clicking on the column name row.
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ReqEdit column management menu displayed by right clicking anywhere on column names

Attributes used in the current specification document can be displayed by opening Setting
> Document and selecting the Attributes tab.

Related topics:

• [4]Filtering and sorting

• [5]Views

1. https://documentation.reqteam.com/reqif-requirements-format/
2. https://documentation.reqteam.com/reqif-requirements-format/
3. https://documentation.reqteam.com/edit-reqif-requirement-files/#Objects
4. https://documentation.reqteam.com/filtering-searching-and-sorting/
5. https://documentation.reqteam.com/view-manager/

Edit ReqIF requirement files (2021-07-22 15:32)

https://youtu.be/La-70CBGDno

19

https://documentation.reqteam.com/reqif-requirements-format/
https://documentation.reqteam.com/reqif-requirements-format/
https://documentation.reqteam.com/edit-reqif-requirement-files/#Objects
https://documentation.reqteam.com/filtering-searching-and-sorting/
https://documentation.reqteam.com/view-manager/


ReqEdit presentation video

Why ReqIF files?

Requirement Interchange Format is the de facto standard for lossless requirement data
exchange for any industry.

ReqIF simplifies the workflow of requirements exchange between suppliers and vendors
in all industries. Mainly driven by the automotive industry.

ReqEdit was built from the ground up to aid the participants of the supply-chain to quickly
use ReqIF files without the need for complex ALM/PLM software solutions. This is becoming
more important with the digital transformation in more and more industries.

ReqIF based interchange offers seamless integration of supply chains in all industries
making collaboration more standardized and efficient.

ReqEdit is an easy tool for ReqIF editing. Creating, comparing and merging requirements
and specification documents with powerfull add-ons.

Large companies rely on lossless data exchange

ReqIF format simplifies and streamlines the data exchange of requirements between
companies or departments and also on the management level. ReqEdit has multiple
licensing models to support corporate environments and use cases.

Medium or small size companies needs cost effective solutions to participate in the
supply-chain

ReqEdit is available as a standalone application. No other dependency is required. Cost

effective solution for processing ReqIF requirement files.

ReqIF file structure
20



ReqEdit follows ReqIF standard on all levels. It will display contents of ReqIF files from
structural to attribute definitions. More details you can find [1]here.

ReqIF format

Attribute Types
atomic data types: boolean, date, enumeration, int, float, string, xhtml

Attributes
uses the basic attribute type definitions with optional restrictions: min, max, length, can
be defined for objects and specifications also

Object types
collection of attribute types that are grouped together

Objects
uses a specific object type and has values for each attribute

Values
value objects for attributes of objects or specifications

Specification Types
a collection of object types and specification attributes

Specifications
uses a single specification type

Hierarchy
requirement object structure inside a specification

Relations
links between the objects
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Edit Objects

Double click on a cell to edit the content. An inline editor appears for XHTML attributes. For
other data types appear corresponding checkboxes or date pickers or single inputs.

To close inline editing click on any other cell.

Use the quick action icons or the right-click menu for text formatting and XHTML content
editing.

22



ReqEdit in inline editing mode, editing main column ReqIF.Text attribute

Single valued enumeration will show a dropdown selector
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Multivalued enumeration attributes are displayed as a list of checkboxes

Dates will show a datepicker

String types editing as simple text

24



Boolean values editing as checkboxes

Integer and float types will only store numerical values
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Insert rows

New rows can be created on the same level or as children to the current row.

For inserting a new row at the same level of the current row, right-click on a cell and choose
where to insert it. A new generic object is displayed as an empty line or with default values.

Each spec object in ReqEdit has the same attributes (columns) in a document. Different
object types are not supported in a single document.

Insert child row creates a new row in the table, below the selected line. It is a child in the
tree hierarchy. A new empty line will appear. In case it is edited it will look like this:

26



ReqEdit displaying context menu, highlighted
are the insert object menu items and the top quick action icons

Delete rows

ReqEdit uses soft-deletions, delete will not remove objects from the ReqIF file.

Delete the selected row by

• selecting the row and pressing DEL or

• right-click menu or

• the quick action icons.
27



ReqEdit displaying context menu, highlighted are the delete menu items

This function places the removed row into a deleted state.

ReqEdit displaying deleted rows with red status indicator, highlighted is the Show deleted
objects icon in the top bar
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Restoring deleted rows

To restore a deleted row select it and click on the „Restore deleted rows” button from the
toolbar or right-click on the object and select the Restore menu item.

PURGE (definitive deletion) of deleted objects

Use PURGE to remove objects, marked as deleted, with all attachments from a ReqIF file.
Purge function is on the delete toolbars and right-click menus.

Once purged, objects cannot be recovered. Auto-backup feature will have 10 snapshots for
recovery.

To clean up deleted rows:

• purge a single deleted row or

• purge all the deleted rows in the entire specification document.

Copy and move rows

Use cut-copy-paste of existing row to create new one. Right-click the desired location and
paste the copied object before / after or as a child row of another row.

If a copied row contains links, on paste, a notification asks what to do with the existing
links.

If the row has child elements, these will also be copied or moved.
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ReqEdit copy-paste menu items

Copy-paste in the Navigator

Use right-click menu in the object navigator to copy-paste objects/rows.
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ReqEdit allows copy-paste in the navigator by right clicking the tree menu items.

If an object contains links to or from other objects, the links are copied too. A pop up
window asks for copying the links or not.

Navigator drag-and-drop

Use drag-and-drop to move objects

Object can be created by CTRL+Drag and release at the desired location

Editing Hierarchy

To change the hierarchy of objects use the promote and demote functions. They are in the
quick action icons, and in right-click context menus.
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Promote / demote objects with right-click menu

Promoting

Will move the object one level up in the hierarchy. If using the drag-and-drop way for
promoting, an object/ row can be moved more levels up or down.

Note: can be moved only one object at once.

Demoting

Move the object one level down as children in the hierarchy

Promote or demote a parent object include promote or demote the object together with its

child objects.

Main column

Main column is a combined cell displaying the most important ReqIF attributes: Re-
qIF.ChapterName, ReqIF.Name, ReqIF.Text

In this cell, the main fields of the document can be edited at once. These fields are XHTML
type attributes.
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Double click the main column of an object displays an inline XHML editor with 3 tabs. One
tab for each attribute.

ReqEdit displaying the inline editor of the main column where ReqIF.Text is selected,
highlighted are the editing context menu and toolbar

The cell content editing menu Copy/Cut/Paste function refers to copy/cut/paste texts
and pictures from the same document and external documents, too. (word file, excel
spreadsheet cells, screenshots, images). The function converts external data format into
ReqIF supported one. (text formatting doesn’t see, image cannot be downloaded). File
format must be ReqIFz to be able to save the images, as attachments.

Note: Depending on corporate internet access, downloading copied images could be
prevented by firewalls. ReqEdit will remove some formattings due to limitations of XHTML
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inside of the ReqIF format.

Copy-Cut-Paste the text of cells of the same ReqIFz file has no limitations regarding the
possibilities shown in the right click menu. (Bold, underline, italic, strikethrough, subscript,
superscript)

Copy-Cut-Paste of tables is with visible borders of cells. ReqEdit will add automatically
borders to tables, even there was no set one before.

Note for experts with HTML knowledge: The HTML Source (experimental) menu item allows
to edit and change the HTML source code of content of a cell.

Limitations on content editing Copy-Cut-Paste function:

• Cell formatting settings in excel spreadsheet

• Attached objects from Wordpad (RTF documents)

• Images can be copy-paste only in ReqIFz files

• If the image/attachment cannot be copied, only file name of the preview images are
displayed.

Recommendation: Before copy-cut content from an external source, save file to have a
backup copy if the copied content is ReqIF invalid.

Properties

Properties menu gives informations about the attachments / inserted files in main column
cells. Right click on the inserted file, Properties
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Right click menu in editor mode shows Properties window

HTML Source (experimental)

This function of the right click menu of content editor is recommended to expert users.
This function allows to view and change the html source code of the attribute/cell.

Note: Currently the changes will not be validated at inserting time. So be very careful at

any change!

Columns

Mass update of attributes

Update multiple rows with a specific attribute value.
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The mass update function is designed to be used together with the filtering. This way, a
set of objects can be selected according to specific criteria and updated at the same time.

The mass update function is not available for the main column

To use Mass update function first define a filter to select all the rows you want to change.
Then right-click on the column header. Select Mass update....A popup window appears.

ReqEdit displaying the mass update menu item by right clicking the column header

Mass update popup window showing options
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Mass update changes all values in the current view for the column.

To change individual cells, select multiple cells from the same column (either Ctrl + click or
Shift + click). Right-click at the column heading to trigger the mass change.

Default values

Each attribute can have a default value defined in the [2]Document settings. Selecting an
attribute and access the “Attribute editor”.

To set back a cells default value for each attribute of a row, right-click the corresponding
cell and select the “Set default value”.

Attachments
37



ReqIF Archive .reqifz files supports file attachments for objects.

Only XHTML attributes can have attachments inside .reqifz files

Image attachments:

png, bmp, jpg, gif, ico, wmf,

File attachments:

any file type is supported

pdf, doc, docx, xls, xlsx ...

Opening file attachments

Double-click on the file’s icon. The attached file is opened by the installed applications on
the machine.

Insert file attachments

To add an attachment right-click the XHTML inline editor area and select Insert image or
Insert file
38



ReqEdit displaying context menu, highlighted is the ’Insert image’ item

ReqEdit displaying attachment previews of an object, contains file icons and preview
39



images

Tables

XHTML attributes by definition can have tables. All tables are rendered inside cells.

ReqEdit displaying tables inside XHTML attributes

To edit XHTML table structure use the inline editor right-click menu.

Save ReqIF files

If your file is a multi-document file, saving one of the documents will also save the changes
made in the other documents of the ReqIF file.

NOTE: Changes on linked documents (e.g. Images or Word, Excel) are not detected. Make
a content change to trigger update and enable saving.

Save as

Save the currently edited file as a new filename. Contents will be identical to the original
one. Can convert ReqIF into ReqIFz.
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Note: Actual file is closed and the file in new saved format will be opened.

Close files

ReqEdit can only close saved files. If there are any unsaved changes, a notification displays
and asks to save files before closing.

Use CLOSE ALL to clean up the editor.

1. https://documentation.reqteam.com/reqif-requirements-format/
2. https://documentation.reqteam.com/document-settings/#Attribute-types

User Interface (2021-07-26 10:16)

Overview

The look and feel of the application is similar to any classic Windows application. It has a
main menu at the top, function icon groups that can be rearranged, main content area and
a status bar at the bottom.

At first run a quick action dashboard is shown.
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ReqEdit start screen showing the dashboard

After opening a ReqIF file, the contents will be shown in the main user interface. If the
ReqIF contains multiple specifications it will be displayed as color coded tabs.

ReqEdit showing a ReqIF file, from left to right: navigator panel, requirements and auto-

backup panel

Specification tabs
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Opening a ReqIF file will display all the specifications as tabs. Same color tabs are from a
single ReqIF or ReqIF Archive file. The specification title is displayed as the tab title.

ReqEdit displaying specifications inside a ReqIF file in color coded tabs

Keeping the mouse over a tab will display more info of the specification like: file location,
document id, and so on.

Closing opened files

Close any tab by pressing the X of the tab or by pressing CTRL+W , if there are any unsaved
changes a popup will ask to save the specification.

Closing all opened specifications of a ReqIF file by accessing File > Close All or by pressing

CTRL+SHIFT+W, if there are any unsaved changes a popup will ask for confirmation.

Navigator

Specification headlines are shown as a tree menu on the left panel. Numbering is added
automatically to aid navigation. Clicking on the items will jump to the same requirement in
the content area.

Show / Hide Navigator

Navigator can be toggled by clicking the pin icon.
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ReqEdit navigator pane on the left showing requirements hierarchy as a tree menu

Requirement Numbering

Requirements with (ReqIF.ChapterName) headlines are shown in a tree menu structure,
numbered by the position in the hierarchy. The numbering is automatically updated on
each change of the requirements, new additions or deletions will affect this.

The levels of the menu represents sub items in the spec hierarchy. This is visible in the
content as sub numbering of a main headline, all the content remains on a single level in
the table.
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ReqEdit displaying a specification where the same requirement is selected in the navigator

and the content area

Content

Requirements are shown in the middle as a table, where the Main Column is a multi content
field and the other columns are the associated metadata.

The Object menu (Right-click)

Right clicking any object (row) in the content area, displays the context menu. Contains
editing functions like: creating, cut-copy-pasting, deleting, restoring, purging objects.
Hierarchical editing si possible by promote / demote menu items.

Manage relations between objects by the lower menu items: Add, Edit, Delete link or Go to
link targets.
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Get the object ReqIF ID using the Copy ReqIF ID menu item.

Main Column

Main Column is the most important content of the specification. It has the default value
of the combination of headline (ReqIF.ChapterName), description (ReqIF.Name), xhtml
content (ReqIF.text). If all there attributes are present it will be displayed together in the
same cell and the headline will have a number assigned to it.

The Main column content can be customized in the Document Settings panel
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ReqEdit displaying a ReqIF file, main column is visible, highlighted is the column separator
and a row separator

Resizing columns or rows

Drag the column header separator bars or the row separator bars to resize the grid.

Content editing

Double clicking on any object will enable the inline editor and activate the text formatting
icon group. Right clicking the content will show a menu for adding attachments or tables
and formatting the content.

To leave the inline editing click anywhere outside the yellow background.
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ReqEdit text content editor, icon group and right click menu

Managing columns

Right clicking the column headers will display a menu, where the selected column or the
other columns can be toggled visible or hidden.

If all the columns are hidden the View manager can reset the visibility back to a predefined
state.
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ReqEdit colum management by right clicking the column header row

Views

Views are visible column sets with optional custom sorting and filtering saved as presets.
The view manager is located in the icon groups on the right side. The views are only for
displaying the ReqIF contents in a more human friendly manner for large files with lots of
metadata.

The view presets are not stored in a ReqIF file, they can be exported and later imported
from the local hard drive.
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ReqEdit displaying the view manager popup window

Backups

ReqEdit offers an auto-backup feature which will create a snapshot of the current state of
the opened files. Default setting is to create a backup every 10 minutes and rotating 10
backup files (the last will be deleted to have a max of 10 backups).

The backup settings can be changed in the User Settings panel

Show / Hide Backups

Backups can be toggled by clicking the pin icon in the title of the panel

ReqEdit displaying a ReqIF file, highlighted is the auto-backup panel

Menus
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File

ReqEdit File menu

New

Create new a new ReqIF file .reqif or an archive with attachments as .reqifz

ReqIF (.reqif)

No attachments

CTRL+N
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ReqIF Archive (.reqifz)

Can have attachments

CTRL+SHIFT+N

A template list will popup will ask for a specific template to use for the new file. For more
information on templates, please read the Templates section.

New Archive

ReqIF Archive supports attaching external images or files to any requirement. Creating a
new archive will show a window asking for a filename.

ReqEdit creating a new ReqIF Archive, popup window asking for filename

Open
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By default, only xml, rif, reqif, zip and reqifz files can be selected

Add new document to current file

Adds a new specification document to the currently active ReqIF file. Use this to add more
than one specification to a single file.

Save

Any change in the specifications will be displayed with asterisk * in the tab.

Changes to linked documents (e.g. Images or Word, Excel) will not be detected by the
editor, a change needs to be made in the requirements in order to be able to Save

Save

Save the currently active file to disk

CTRL+S

Save As

Save the active file under a new name

Keep all UUIDs

CTRL+SHIFT+S
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Save as template

Single document ReqIF files can be saved as a template and reused later

Close

Opened specifications can be hidden by clicking the X in the tab bar, if there are unsaved
changes a popup will ask for confirmation. This is not removing the specification from the
file.

Close All

Close all opened specifications, any unsaved change will notify the user. It will close all
opened files.

Import

Start an import wizard for ReqIf 1.0.1 files

Export

Start an [1]export wizard from ReqIF 1.0.1 to ReqIF compatibility mode or RIF 1.1 / RIF
1.1a arhive format.

Print

Print the current specification Main Column or all visible columns.
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Connect

Requires ReqEdit file server

Will authenticate the current user and create a connection

Check out

Requires ReqEdit file server

Lock the file and download for editing (other users that have permission to the same file
cannot download it)

Check in

Requires ReqEdit file server

Upload a file to the server. If the file was previously locked by the user it will become
unlocked and can be edited by others as well.

Edit
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ReqEdit Edit menu

Editing objects and contents

Object / Requirement level editing

Create before, after

Create child

Promote, demote

Delete (soft delete)

Restore deleted (soft deleted)

Purge (hard delete)

Cut/Copy/Paste
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Content level editing

Table editing

Find

Replace

View

ReqEdit View menu

Attributes (columns) related

Filtering

ReqEdit can show a sub-set of the requirements based on special conditions of the at-
tributes. Filters can be set and reset. Filters will not be saved inside ReqIF files.

Sorting
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ReqEdit can sort the requirements based on multiple columns. It can be configured and
then reset. The sorting is not saved inside the ReqIF file.

Show/Hide deleted requirement objects

Soft deleted objects will be marked for deletion but are not removed from a specification
until PURGE is not pressed. The deleted objects can be shown or hidden

View definitions (views)

Views are a sub-set of the attributes that are displayed. The views are not saved inside
the ReqIF. file Views can be exported and later imported.

The views can be imported and used on any specification as long as there are attributes
with similar names.

Settings

ReqEdit settings menu

Expert users can fine tune ReqEdit for their specific use case, and configure lots of ReqIF
settings

Document settings

Manage ReqIF file internal settings

Attribute Types

Attributes
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Document attributes

Links

Configure Main Column display settings

Server settings

ReqEdit file server connection settings

Server user credentials

User settings

ReqEdit internal configuration

Interface language

Auto backup settings

Doors table display settings

Cache size

Dashboard startup
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Add-ons

ReqEdit Add-ons menu

Displays all available add-ons which are active in the current license. Descriptions below.

Help

ReqEdit Help menu

Contains a user guide. Can display Information about the active license. Display keyboard

shortcuts. Check for online updates. Display version information about the current ReqEdit

release.

Add-ons

ReqEdit Ultimate comes with powerful addons that extends the base functionality.

Xml Editor
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Look inside ReqIF files and check the xml code. The editor comes with a built in ReqIF
validation function that will debug any invalid code. Read more [2]here.

Excel importer

Turn your excel files into ReqIF files. Data exchange is more realiable and lossless if ReqIF
is used. Read more [3]here.

Compare / Merge tool

Will generate a comparison report that can be handed out as a signle html file. Read more
[4]here.

Weak-word Analysis

Weak words are words that are confusing for readers and should be avoided if possible.
This tool provides a case insensitive whole word search for this purpose, optionally writing
the results back in the ReqIF file. Read more [5]here.

License Detach tool

Take ReqEdit out of the licensing environment. This power feature will enable users not to

depend on the local licensing servers and to be able to work from anywhere. Read more

[6]here.
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Expert knowledge

Tab title configuration

ReqEdit exposes some settings that can be configured for the tabs. The configuration file
is located in AppData\Local\REQTEAM\ReqEd it\ReqEditSettings.xml

Setting Values Notes
TabDocumentTextAlign Left, Right Alignment of document title in the tab
TabDocumentWidth 250px width of the tabs in pixels

Keyboard shortcuts

Ctrl+O Open file
Ctrl+N New file
Ctrl+S Save file
Ctrl+Shift+S Save as
Ctrl+W Close file
Ctrl+Shift+W Close all file
Alt+F4 Close application
Ctrl+D Delete Sorting
Ctrl+F Find text
Ctrl+H Replace text
Ctrl+E Add new or edit filter
Ctrl+A Deactivate filter
Ctrl+Q Delete filter
Alt+N Add new object below
Alt+Shift+N Add new child object
Ctrl+Tab Switch between open tabs
Ctrl+C Copy text information inside the cell
Ctrl+X Cut text information inside the cell
Ctrl+V Paste text (remove all formatings)
Ctrl+Alt+S Start link
Ctrl+Alt+E End link
Ctrl+Alt+R Reset start link
Ctrl+Alt+R Reset start link
F1 Open help
F2 Open selected cell in edit mode
F3 Check for update
F5 License information
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F6 XML Editor
F8 Document settings
F9 Shortcut window

1. https://documentation.reqteam.com/?p=2386
2. https://documentation.reqteam.com/xml-editor-add-on/
3. https://documentation.reqteam.com/excel-importer-add-on/
4. https://documentation.reqteam.com/merge-compare-add-on/
5. https://documentation.reqteam.com/weak-word-analysis-add-on/
6. https://documentation.reqteam.com/license-detach-utility/

Filtering, Searching and Sorting (2021-07-26 10:17)

Filtering

Filtering can be used to display only a subset of objects based on specific criteria.

Filtering is temporary, rules are not saved.

From the toolbar create filter, enable / disable current filter, delete filter can be used.

ReqEdit toolbar highlighted are the filtering icons

Filters can be constructed by the toolbar icons, then later edited or deleted.

63

https://documentation.reqteam.com/?p=2386
https://documentation.reqteam.com/xml-editor-add-on/
https://documentation.reqteam.com/excel-importer-add-on/
https://documentation.reqteam.com/merge-compare-add-on/
https://documentation.reqteam.com/weak-word-analysis-add-on/
https://documentation.reqteam.com/license-detach-utility/


ReqEdit filter editor popup window

Searching

Activate the search bar from the toolbar or by pressing CTRL+F

ReqEdit search bar displayed above the main content area

Search can be done in three contexts:

• Main Column: search only in ReqIF.ChapterName, ReqIF.Name, ReqIF.Text

• Entire document: all attributes
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• ForeignID: search only in ReqIF.ForeignID (only if the attribute is present in the current
document)

ReqEdit searching, found result displayed in green cell background

Search and Replace

Replacing values or part of values depending on the search can be done by pressing
CTRL+H enabling the replace bar

The replace function works only for the Main Column

ReqEdit displaying Search and Replace bar above main content area

Skipping a specific replacement press the Next button

Replace all will do the replacements in the contents of the Main Column then display the

total count of replacements.
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Sorting columns

Columns can be sorted ascending or descending by clicking or by right clicking on the
column header. Each sort will reset the previous sorting.

ReqEdit column sorting menu by right clicking on the column headers

Multi-column sorting

To have multiple sorting CTRL+click the column headers you want to sort. A numbered
arrow will display the sorting order. To change the ordering press CTRL+click again on the
column

ReqEdit multi column sorting displayed by numbered arrows in the column headers

Reset sorting

Press the delete sorting icon in the toolbar or press CTRL+D
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View Manager (2021-07-26 10:18)

What are views?

Views are visible column sets with optional custom sorting and filtering saved as presets.
The view manager is located in the toolbar icon groups on the right side.

The views are only for displaying the ReqIF contents in a more human friendly manner for
large files with lots of metadata.

The view presets are saved in the ReqIF file

Views can be exported and later imported from the local hard drive
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ReqEdit displaying the view manager popup window, highlighted is the view manager
toolbar

There are two system views defined per each document which cannot be deleted:

All Attributes - show all the columns in the document

Main column - show only the main column

View selector in the toolbar

Manage views

To be able to manage views user defined views has to be created by clicking the Create
new view icon

View toolbar icons, selected is the Create new view icon

Create or edit views

Pressing the Edit view icon the view editor popup window is displayed. The toolbar icons
are:
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• Rename

• Save

• Save and Apply, will show the applied view in the main content area

• Delete after confirmation the view is deleted

• Make a copy of the view by setting a new name

• Export the current view in a .view file

• Import .view files. Only existing column names are imported

• Cleanup, will leave only the visible columns in the document, a confirmation popup
lists all the views / attributes that will be removed. This operation saves the document
so a backup is highly advised.

View editor window
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Filtering

Views can inherit filtering from the current document. Press Copy filter from editor to save
the filter into the view.

Show deleted objects filter can also be used

Toolbar

Creating new views

Clicking the Add View button will ask user for the new view name and preparea it will all
the attributes added to it

Editing views

User can edit the view in the main gui with rightclicking the column names or by opening
the View manager panel by clicking the icon to the right

View manger toolbar, highlighted is the Edit
view icon

Deleting views
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User can delete the selected view if it’s not any of the system views by clicking the Delete
View button located in the toolbar

Links (2021-07-26 10:18)

What are links?

Relation between objects are called links. Each object can have incoming and outgoing
links to / from other objects.

In ReqIF files links are stored in named LinkSet definitions which basically are a group of
specific links between objects.

For example: Satisfies LinkSet has links that are between objects of use cases and tehnical

definitions

How links are displayed in ReqEdit?

If an object contains links, a link symbol and arrows indicating the link type are displayed
inside the status indicator column. The red arrow indicates an incoming link and the green
arrow indicates an outgoing link. If an object contains both types of links, both types of
arrows are dispalyed.
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ReqEdit displaying context menu for an object with links

Go to links

To follow a link to its destination or source, you have to perform a right click on the object
row and go to the „Go to links” menu item. A submenu will open and dispaly the available
links. A submenu item contains a symbol for incoming or outgoing link and according text
„Go to source” or „Go to target” and also the object text (in case there is any available) or
the ReqIF ID of the source or target object.
A link can be incoming from or outgoing to an object from the same document but also
to another document. When clicking on a link in the submenu, the linked item will be
selected and displayed on the first row in the grid. If the linked object is contained in
another document, the program will automatically switch to the document’s tab and select
the linked object. If the document containing the linked object is not opened in ReqEdit,
the program will ask if you want to open it.

NOTE: Currently we only support links between objects inside the same ReqIF file. If an
object contains a link to another ReqIF file, the text „The target is placed in an outer file...”
will be displayed in the links menu.

Links administration

The link administration tab can be accessed from the “Document Settings” window.
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ReqEdit link settings window

In this section, all link sets related to the selected document can be viewed and admin-

istrated. You can change the link set name and description and also edit each individual

link’s name and description related to that link set.

Add links

In order to create a new link, first you have to create a “start link” by right clicking on an
object and then going to the “Add link” menu and clicking on “Start link” in the submenu.
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After creating the start link, an icon will appear in the status column of the source object.

The next step is choosing a target object for the link. You can do this by right clicking on an
object and selecting “End link” from the “Add link” submenu.

Next, you can add links to some other objects starting from your source object, by repeating
the last step. After you added all your links from the source object, you can click on the
“Remove start link” menu item from the “Add link” submenu.
After removing the start link, you can add a new one to another object.

External Links

ReqEdit offers you the possibility to store external links in your ReqIF document. This can
be either an OSLC or a Web URL. Please select in the row you want to link and use the
right mouse click to open the related menu and select the entry “Add external link”. After
selection, you will see this input dialog.

You can define with the long name a display name for the link. In the field URL please enter
a valid URI (including protocol prefix like http:// ). The field link type is optional, and should
be used to classify links (like derives, implements).
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For the link direction, you can choose between INWARDS and OUTWARDS. The selection
has no impact on the function, it is just a semantic. The field technology determines how
the link is intended to be open. Currently all links will be opened with your default browser.

You can add an additional description to the link as well. If you now press “Save” button,
you will see the link in the Go to links menu with the selected name. If you don’t define a
name the URI will be displayed.

If you want to edit the external link, than please select in the right click menu the entry
“Edit external links” and select the link you want to edit:

If you click on the edit button, then you will get the same dialog described before. Here
you can edit all the properties of the external link.

Please take in consideration, that this feature is not implemented currently by all tools,
that support ReqIF. This information may get lost if you import the ReqIF file generated
by ReqEdit to other tools, that not support this feature.

Delete Links

In order to delete a link, you have to right click on an object that contains one or more links
and go to the “Delete link…” menu item. After clicking it, a window containing all links of
the object will be displayed.

Only outgoing links can be deleted from an object. If you want to delete an incoming link,
you have to delete it from the source object.
For deleting outgoing links you have to select them by clicking on the checkbox at the
beginning of the rows and click on the “Delete” button afterwards.

Incoming links have a grey background and cannot be selected.

Printing (2021-07-26 10:19)

How to print requirements?
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ReqEdit supports printing the Main Column or all the visible contents of the current docu-
ment. File > Print will show the two options.

Print Main Column

Print All visible columns
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Customize the current view with filters and sorting to prepare a custom view for the print.

Customize the output
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ReqEdit offers print customization of the header, footer and cover pages. Access the File >
Print > Settings menu item for displaying the customization window.

Print customization

Settings (2021-07-26 10:19)

Expert users can fine tune ReqEdit for their specific use case, and configure lots of ReqIF
related settings

ReqEdit settings menu
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Document settings

Manage ReqIF file internal settings

Attribute Types

Attributes

Document attributes

Links

Configure Main Column display settings

Server settings

ReqEdit file server connection settings

Server user credentials

User settings

ReqEdit internal configuration

Interface language
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Auto backup settings

Doors table display settings

Cache size

Dashboard startup

Document Settings

Read the chapter [1]Document Settings for an in depth overview.

User settings
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User settings window

ReqEdit can be displayed in two languages: English and German.

To change the language, press Save and then restart ReqEdit.

Temporary files

Using ReqIF files produces temporary files like: previews, caches, ReqIF Archive objects,
etc. To clean the user space use the Delete temporary files button

Backups
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When a file is saved for the first time, ReqEdit automatically makes a backup copy of the
initial state of the file and also starts the timed backup process. By default, the program
creates a backup every 10 minutes until it reaches 10 backup files. After that, the oldest
backup file will be overwritten. The number of minutes and number of backup files can be
changed by the user in the User settings panel.

ReqEdit displaying a ReqIF file, highlighted on the right side is the auto backup panel
displaying available backups

The timed backup process can also be disabled by unchecking the [Create backup] check-
box in the Settings > User panel.

By default, ReqEdit stores the backups in the Windows user folder. This is a Windows 7 lo-
cation sample: C:\Users\user _name\AppData\Local\ReqEditackslashReqEdit\BackUpFiles

The locations of the Log and Backup folders can be changed. More information can be
found in the Program environment chapter.

Image caching
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Limit the RAM memory used by ReqEdit. Default value is 500mb, but can be increased to
gain more speed.

ReqEdit uses image caching to speed up displaying XHTML contents of the ReqIF files. If

the ReqIF files are big, increasing the cache size could be a good idea.

Server settings

This requires a ReqEdit Server instance and to be accessible on the internet.

Read more on the Collaborative work with ReqEdit Server

The focus of ReqEdit Server is to keep the file management effort as low as possible. The
server offers a central point where you can organize and work with ReqIF files in ReqEdit.
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ReqEdit Server settings

Enter credentials for ReqEdit Server and press Test Connection then Save.

Once a valid configuration is saved press Connect from this window or from the toolbars or
the File menu.

ReqEdit Server connection toolbar

1. https://documentation.reqteam.com/chapter/document-settings/
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Error reporting (2021-07-26 10:19)

Crash reports

When a fatal crash happens, ReqEdit tries to collect non sensitive information about the
situation. A notification asks to send the crash report to REQTEAM ticketing system for
analysis.

ReqEdit fatal crash popup window

Contact support

For any questions use the documentation platform [1]https://documentation.reqteam.com.

Or contact ReqEdit Support for assistance through email to: support@reqteam.com.

1. https://documentation.reqteam.com/

Notices and Limitations (2021-07-26 10:19)

Specification document naming
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Document names can only contain alphanumeric, space, period, underscore, hyphens

characters.

Logging

ReqEdit is producing a non-sensitive action log (does not contain actual values only action
names) of each opened document.

The log files can be found here %AppData %\..\Local\ReqEdit\ ReqEdit\Logger

The log file is really helpful for analysis when ReqEdit crashes.

OLE Objects

OLE was is a proprietary technology developed by Microsoft that allows embedding and
linking to documents and other objects.

Only ReqIF Archive .reqifz files support this feature

Import large OLE Files in ReqEdit

In some cases memory limitations will limit the OLE object conversion, in this case the OLE
object will be wrapped inside an RTF file. Opening the OLE objects will only be possible
through MS Word.
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For any OLE conversion ReqEdit needs the memory 20 times the size of the OLE object.

Import large OLE Files to DOORS

Exported files that have OLE objects larger than 40-45MB cannot be imported into IBM
DOORS that is connected to IBM DOORS server 9.5.

Preview

ReqEdit is not able to generate preview images during imports or if they are directly added
in the application. A file-type icon will be displayed instead.

Handling

Atego Requirements Synchronizer version 2.4 and IBM Rational DOORS 9.5.2. OLE objects
can be imported and opened by ReqEdit.

DOORS roundtrip

• Export always to an empty directory then archive only the contents of this directory to
a zip file

• Check if the ReqIF file and all of the OLE objects are in the root folder of the archive

• Rename the file to .reqifz

• Import this file to ReqEdit

• Edit the file

• Export the file to to IBM Rational DOORS
87



Import to DOORS 9.4

Extract the ReqEdit exported file to an empty directory before importing to DOORS

If exports are done directly by IBM Rational DOORS, in most of the cases DOORS will not
make the preview images. Only a small broken link icon is displayed as a preview image,
but the linked OLE object still exists in the export.

Don’t delete the broken image icons, it is important for the linked OLE object.

Copy / Paste

Copy-paste from external sources will try to keep all formatting from the text.

Image or file copy-paste is partially supported. Drag & Drop of images from external
applications like browsers are not supported.

Copy and paste of complex tables may occur problems with ReqEdit.

Limitation of entire function of copy paste on Windows Servers, because of limitation of the

Internet Explorer on the server. For detailed description of limitations [1]click here.

Open and save files from ReqEdit Add-ons

The limitation can affect all ReqEdit Add-ons (Excel import, View manager, Compare, XML
Editor) where it can not open or save files from / to a network share, which is connected
with other user credentials, than the Windows current user.
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For detailed description of limitations in the Excel importer Add-on [2]click here.

1. https://documentation.reqteam.com/windows-server-2019-2022-copy-paste-limitation/
2. https://documentation.reqteam.com/excel-importer-add-on/#Limitations

Importing (2021-07-26 10:20)

The Import add-on opens non-standard ReqIF files and imports MS Word document files, or
MS Excel spreadsheets. To import click on File / Import...

ReqEdit Import wizard window

RIF, ReqIF Import

Some ReqIF files are not following the format standard. ReqEdit can still open these files
by converting to a compatible format. Following formats are supported:
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IBM Rational DOORS compatible ReqIF file to ReqIF 1.0.1 format

Rational DOORS Next Generation

RIF 1.1a to ReqIF 1.0.1 format

The ReqEdit editor supports the ReqIF Format coming from tools that are on the market. So
the file attachments and images are stored in the archives as they are (no conversion of
any type necessary) and for formatting we are using the XHTML tags that are designated
for this purpose.

Not all tool vendors share this spirit, and they have their own kind of implementations
that need to be adapted. One of these tools, IBM Rational DOORS, uses for external file
reference an OLE wrapping around each of the files. This is ReqIF compatible, but not the
standard.

ReqEdit needs to un-wrap this OLE object to get to the original file. This is happening during
the import. ReqEdit creates a new file, with all the original files inside. The filename is
kept as the original one, but has an additional suffix called “ _imported” in the name. This
imported file can be edited. The linked external files can be opened with an application for
the specific file type.

In order to edit files coming from DOORS (directly or via Atego Requirement Synchronizer)
you need to execute an import, by clicking on File->Import.

NOTE: IBM Rational DOORS version. 9.5.2 and Atego Requirements Synchronizer 2.4 have
been tested.

By clicking the “Import” menu item, a wizard will be opened and guide you through the
import process.
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Import wizard

On the first page of the wizard you will find some information about the wizard and a link to
the documentation. By selecting the “Do not show me this start page next time” check-box,
this page will not be shown anymore on the wizard start-up.

In the next page of the wizard, the format of the file you want to import has to be selected.
The available options are “IBM Rational DOORS© compatible ReqIF format” and “RIF 1.1a
format”.
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Import options

The following page lets you select the file you want to import and also the destination path
and name for your output file.

Import path

After the file is imported, a confirmation page will be displayed. You can select the “Open
92



the imported file” check-box if you want to open the file after the wizard is closed.

Succesfull import

NOTE: If you import a file from RIF format, another page containing mapping tables will be
displayed after the pre-validation. This page contains tabs for each file (in case of a RIF
archive) and for each document contained in the xml files. For each document you can set
the destination attribute name for every source attribute.
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Import Log file

MS Office Word Import

The Word Importer option imports .DOC files (Word 97-2003 type) into ReqIF.
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Word Import wizard starting from v 2.19

Note: for a precise outcome, a table mapping file is needed for importing Word files,
although it is also possible without it.

Structure of the Word file

Before starting the import process

Simple structuring of the document is needed to mark headline depth which will be
converted to nested objects

H1...H5
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source Word file with multiple child headlines
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resulting ReqIF with nesting

Mapping

Table mapping

To convert tabular data to objects with attributes a manual mapping is needed that will be
used throughout the document
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ID | Renamed ID | integer
Heading | ReqIF.ChapterName | text
Text| ReqIF.Text | text
Comment | Comment | text
Integer | Integer | integer
Real | Real | real: .
Date | Date | date: dd.MM.yyyy

The mapping syntax is <table column name> | <target attribute name> | <attribute type>

Where attribute types can be integer
text
real:<decimal separator> decimal separator string , / . (comma or point)
date:<date format> date format supports standard date notations
enumeration NOT SUPPORTED

Mapping file

To convert Headings to objects with attributes a manual mapping is needed that will be used
throughout the document

ID | Renamed ID | integer
Heading | ReqIF.ChapterName | text
Text| ReqIF.Text | text
Comment | Comment | text
Integer | Integer| integer
Real | Real | real: .
Date | Date | date: dd.MM.yyyy

Import .doc file

Before importing a doc File(Format 97-2003) please ensure it is not open in any other appli-
cation, then in ReqEdit click on the File/Import... or Import files in the dashboard. A Wizard
window appears and leads you through the import process.

Browse for the document file and give the imported file destination. Then click Next.. Basi-
cally, the name of the ReqIFz file will be the same as the document’s name plus ’imported’.
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After selecting the source files , destination file becomes the "imported" name

In the next Window you can select the import options.
99



Word Import Wizard

General options

Keep hierarchy information will show the objects at levels based on Heading settings.

Remove manual chapter numberings option will remove the chapter numberings of
ReqIF.

Combine list elements in one object will show the whole list in one object in ReqIF.

The wizard allows the import options of tables, attributes and attachments.

Attribute parsing is possible only if a mapping file is given.

The Page selection allows selecting parts of the document to be imported. Given values
must be integers of existing page numbers of the document.

Note: If ReqEdit cannot open the document file, the page selector is not live and the docu-
ment cannot be imported.
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Select the mapping file for Attribute parsing
Resulted ReqIF file after Word import
The resulted ReqIF file contains 5 new Attributes:

• Page - shows the page number in the Word file where the object/row is

• Paragraph - shows the number of paragraph in the Word. For details check the Re-
qedit/Systemlog/ReqEditEventLog file.

• Item number - shows the bullets or numbers of a list

• Footnote - shows the footnote related to the object in the Word file

• Comments - shows the comments related to the object in the Word file
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New attributes in the ReqIFz file after importing a .doc file

Resulted ReqIF file screenshot after some import option settings

Limitation of Word import
Currently the Word import has these limitations:

• Our current library has a very poor support of the DOCX format, so importing .docx is
not supported; we are working on a new version which will omit this limitation

• Detection of form field, and draw (pen and marker) are not supported

• Importing files bigger as 150 MB not supported

Excel spreadsheet Import
Excel spreadsheet import can support:

• Enabling roundtrip and

• Simple import with or without hierarchy

For roundtrip enabled import click on File / Import or Add-ons / Excel Import and choose
the box Enable round trip in the Excel import wizard window.

For details on Excel Import click [1]here.
102



Excel Import Wizard
1. https://documentation.reqteam.com/excel-importer-add-on/#Usage

Exporting (2021-07-26 10:20)

RIF, ReqIF

If the files that the user edits or creates should be imported to IBM Rational DOORS (directly
or via Atego Requirement Synchronizer), an export is necessary.

After editing and before importing to DOORS, you have to do an export by clicking on
File->Export. During the export all the linked files will be wrapped in an OLE envelope. To
protect the ReqEdit variant of the ReqIF file, the export function will ask the user for a new
file name, where to save the DOORS variant. This new file can be imported to IBM Rational
DOORS.
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NOTE: IBM Rational DOORS version. 9.5.2 and Atego Requirements Synchronizer 2.4 have
been tested.

By clicking the “Export” menu item, a wizard will be opened and guide you through the
export process.

On the first page of the wizard you will find some information and a link to the documenta-
tion. By selecting the “Do not show me this start page next time” check-box, this page will
not be shown anymore on the wizard start-up.

In the next page of the wizard, the format of the file you want to export has to be selected.
The available options are “IBM Rational DOORS© compatible ReqIF format” and “RIF 1.1a
format”.
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The following page lets you select the destination path and name for your output file. In
case you want to export to RIF format and your file is a multi-document file, multiple .zip
files will be created at export. In this case, only the destination folder can be selected and
the file names will be assigned automatically.
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After selecting the file paths, the wizard will convert your file and a confirmation page will
be displayed.

You can find your exported files in the destination directory you have specified on the
previous page.

NOTE: If you export a file to RIF format, another page containing mapping tables will be
displayed after you select the file paths. This page contains tabs for each file (in case of
a multi ReqIF file archive) and for each document contained in the .reqif files. For each
document you can set the destination attribute name for every source attribute.

106



Configuration

This document is incomplete, we are working on making it better

Thank you � for your understanding

TODO incomplete: needs config and export finish

License Detach Utility (2021-07-26 10:52)

To be able to work outside of the restricted environment and self hosted license server,
licenses can be locked for on the go usage. Each detached (locked) license will have an
expiration period after which automatically will be restored and the PCs will not be able to
use ReqEdit anymore.
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Read more about [1]Detaching Tool setting

For detaching another license the PC has to be inside the network after which the detach-

ment can be done again.

Environment

ReqEdit is used inside a restricted network where the PCs cannot access ReqEdit License
Server, a self hosted network license server is used. This server holds all the license pools
available to the network.

When ReqEdit has to be used outside this environment a license can be locked and
detached for on-the-go usage.

NOTE: Detaching has to be done inside the restricted network before disconnecting.
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Diagram showing ReqEdit usage in a restricted environment where a stand-alone license
server is used,
detaching a license for on the go usage

Work on-the-go

Detaching licenses from network server

Start the tool by selecting Add-ons > License Detach from the top menu

Detach Tool Add-On Tab

License Detach tool add-on will be displayed. The available number of licenses will be
listed in the window (refreshed every 20 seconds).

Select the license that needs to be taken out and configure the period.
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Detach tool add-on window

Press Detach license to reserve a license and take it out.

Detach tool displaying a detached license

ReqEdit can be used on the go for the configured period, after which the license will expire

and cannot be used. Another license has to be detached again from inside the network.

Logging

The Log entries tab displays the last 100 messages in reverse order. To get the complete
log message click on Open full log file on the bottom of the page.
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1. https://documentation.reqteam.com/activation/#License-detaching

Requirement Templates (2021-07-26 10:54)

Templates for Requirement Engineering

ReqEdit offers templates for different use cases between customer and supplier according
to [1]Prostep[2] ivip Recommendations. Please keep in mind that only ReqIF Archives
(.reqifz) supports images/file attachments.

To open a template click File / New Archive ... You can select from different templates.

Template prostep ivip - All attributes

You can use this template in relation with your suppliers for request clarification for a single
product variant use case.

Template prostep ivip - All attributes

The template includes the necessary attributes, as

Customer status, with the options Not To Evaluate / To Evaluate / Accepted / Not accepted /
To be clarified / Proposed to discard / Discarded.
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Supplier status, with the options Agreed / Not Agreed / Agreed with comment/ To be clarified
/ Discard Deployed.

The attributes of this specification documents are:

Attributes added in the template prostep ivip - All attributes

Template prostep ivip - with Product variant

This template helps tracking the statuses of requests if there are more product variants.

The attributes Customer status and Supplier status have the same values as in case of
template Template prostep ivip - All attributes.

Template prostep ivip - with Product variant
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Attributes added in the template prostep ivip - with Product variant

Template prostep ivip - with Revision

This template includes an attribute Revision, for use cases where they are needed. The
attributes Customer status and Supplier status have the same values as in case of template
Template prostep ivip - All attributes.

Template prostep ivip - with Revision
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Attributes added in template prostep ivip - with Revision

Template prostep ivip - simple

This template includes only the main attributes of a requirement document. The attributes
Customer status and Supplier status have the same values as in case of template Template
prostep ivip - All attributes. Attributes as Revision or Product variant are not included.

Template prostep ivip - simple
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Attributes added in template prostep ivip - simple

Agile templates

We recommend to use ReqIFz (archive) for the following templates. You can add each of
the templates to a single Archive with File / Add -> New document to the current file. So
it’s possible to link user stories, bugs and test cases and add images/ file attachments.

Scrum - Backlog

This template can be used to have a list of the client’s requirements. You can write epics,
user stories, or just mark text as information or heading (in the Type column). Different
colors for each status help visually the user. Each requirement can have different status:
New / Draft / Final / In Progress / Obsolete / Implemented / Duplicate. The template
includes also "Business Value" and "Definition of Done" Columns.
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Template Scrum - Backlog

Scrum - Buglist

This template collects and lists the bugs reported by users / customers / internal stake-
holders. The user of the template can set in the Type column Bug / Heading / Information.
The column Status can be set as New / Open / In implementation / Solved / Not Fixed.
The Column Scope can be set as Installer / GUI / Business logic / Plugins. There are two
additional attributes to add the sprint number/iteration, when a bug is fixed, and also a
Bug identifier.

Template Scrum - Backlog

Scrum Test

This template can be used for test documentation. The column Type can set texts as
Heading / Information / Test Suite / Test Case / Test step. The Column Status sets as New
/ Draft / Final / Obsolete / Duplicate. The template includes place for Test description and
Expected results.
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Template Scrum - Test

1. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf
2. https://www.prostep.org/fileadmin/downloads/Recommendation_ReqIF_V2.1_final.pdf

License activation (2021-07-26 10:54)

General overview about the license activation options. For more details, click [1]here.

Automatic activation

Activation is automatic for trial version and for some custom-tailored versions.

Online activation

(Public environment, internet/online access with no restriction)
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The License activator window appears. In the text box enter the Product key and press the
Activate button

Diagram of public environment with direct connection to ReqEdit License Server

Follow the [2]Activation steps

Offline activation

(Limited environment, with restriction on internet/online access)
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LicenseActivation.exe

Access to ReqEdit License Server is restricted or not available. Manually activate license
for the machine where ReqEdit is running.

Offline activation with LicenseActivation.exe

Offline Activation with [3]LicenseActivation.exe

RUS Tool
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Offline activation with RUS tool downloaded from the ReqEdit License Server

Offline Activation with [4]RUS tool

Network license server ACC

(Public internet access is restricted due to internal security policies, and only a local license
server is accessible)

A self-hosted licensing server is installed on the restricted network. The server holds all the
ReqEdit licenses, that can be accessed from any workstation inside the company network
(no local license installation necessary).
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Diagram of restricted environment with self hosted ReqEdit License Server

Setting up the [5]Network license server

License detaching

Note: please inform REQTEAM if you plan to use detaching, so the license can be generated
for this purpose.

When users want to have a working copy of ReqEdit outside the restricted environment.
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License detaching is possible by using the Detach Tool Add-on.

Detaching licenses will lock the license for a period of time for a specific machine. Locking a
license has to be done inside the restricted environment, after which it can be disconnected
from the network.

Diagram showing detach mechanism to work outside network license server

[6]License detaching

1. https://documentation.reqteam.com/license-management/
2. https://documentation.reqteam.com/activation/#Online-activation
3. https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe
4. https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool
5. https://documentation.reqteam.com/activation/#Self-hosted-license-server-(Network-license)
6. https://documentation.reqteam.com/activation/#License-detaching
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Batch Mode Automatization (2021-07-26 10:55)

ReqEdit can be used without GUI in a command line to import or export ReqIF files.

Batch mode functionality:

• Import RIF1.1a to ReqIF

• Export ReqIF to RIF1.1a

• Import from MS Word (.docx) to ReqIF

• REQXML to ReqIF, [1]read the xml format specification

Examples

Import from a RIF11a to a ReqIF file

ReqEdit.exe -batch -in "D:\Workplace\Input Folder\requirements.zip" -out
"D:\Workplace\Output Folder" -mapping "D:\ Workplace\RifToReqif.txt" -jobid
"001" -logfile "D:\Workplace\Log.txt"

Export from a ReqIF to a RIF11a file

ReqEdit.exe -batch -in "D:\Workplace\Input Folder\requirements.reqifz" -out
"D:\Workplace\Output Folder" -mapping "D:\ Workplace\ReqifToRif.txt" -jobid
"002" -outtype RIF11a -logfile "D:\Workplace\Log.txt"

Export from a ReqIF to a REQIF DNG file (obsolete)
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ReqEdit.exe -batch -in "D:\Workplace\Input Folder\requirements.reqifz" -out
"D:\Workplace\Output Folder" -jobid "003" -outtype REQIFDNG -logfile
"D:\Workplace\Log.txt"

Import from a Word .docx to a ReqIF file

ReqEdit.exe -batch -in "D:\Workplace\Input Folder\requirements.docx" -out
"D:\Workplace\Output Folder" -mapping "D:\ Workplace\WordToReqif.txt" -jobid
"004" -logfile "D:\Workplace\Log.txt" --keephierarchy
-removechapternumberings --tables --attachments --images -attributetable row

Import from REQXML to ReqIF file, read more here: [2]REQXML format

ReqEdit.exe -batch -in "D:\Workplace\Input Folder\requirements.reqxml"
-out "D:\Workplace\Output Folder" -jobid "003"
-mapping "D:\ Workplace\ReqXmltoReqIF.txt" -logfile "D:\Workplace\Log.txt"

Parameters
General batch parameters -batch mandatory
enable batch mode without displaying GUI
-in mandatory
indicates the input file
-out mandatory
indicates the output folder
-mapping optional
used only for ReqIF RIF conversions
if a mapping is not specified, the default mapping of the system attributes is used
-jobid optional
sets a custom prefix for the output file
if not set, the output file will have a datetime prefix
-logfile optional
indicate the absolute path to the user desired logfile
if the logfile already exists, the new information will be appended
if not specified, the logs will be written to the standard ReqEdit log

ReqIF and RIF import/export parameters -outtype indicate the output type
possible values are "RIF11a", "REQIF" or "REQIFDNG" for Rational DOORS Next Generation
compatible files

Word import parameters -keephierarchy optional
will recreate the parent/child hierarchy in the Word file based on Heading levels. If not
enabled, all Headings will be displayed on the first level
-removechapternumberings optional
removes manual chapter numberings
-tables optional
all tables will be converted to a ReqIF compatible (HTML) table, else all tables in the file will
be ignored
-attachments optional
embedded objects (Word (rtf, doc, docx), Excel (xls, xlsx), Powerpoint (ppt, pptx)) in the
Word document will be imported to ReqIFz file and referenced inside the ReqIF object, else
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all objects in the Word file will be ignored
-images optional
embedded images (JPG, PNG, BMP) in the Word document will be imported to ReqIFz file
and referenced inside the ReqIF object, else all images in the Word file will be ignored
-attributetable optional
possible values “row” or “column”
the word document parser will look in the first row/column of all tables for the values given
in the mapping file to assert if the table should be treated as an attribute table

NOTE: Parameter values which contain empty spaces or special characters like slash, back-

slash and others, need to be written between quotes

Mapping file
The mapping files are used to translate attribute names from RIF to ReqIF standard and vice-
versa. The mapping file is a simple .txt file with the format shown below in two examples
with IBM DOORS system attribute names and two custom attributes displayed with red text.
Example of a RifToReqif mapping file

Absolute Number - ReqIF.ForeignID
Created By - ReqIF.ForeignCreatedBy
Created On - ReqIF.ForeignCreatedOn
Created Thru - ReqIF.ForeignCreatedThru
Last Modified By - ReqIF.ForeignModifiedBy
Object Heading - ReqIF.ChapterName
Object Number - ReqIF.ChapterNumber
Object Short Text - ReqIF.Name
Object Text - ReqIF.Text
Description - ReqIF.Description
Customer_Description - Supplier_Description
Customer_Status - Supplier_Status

Example of a ReqifToRif mapping file

ReqIF.ForeignID - Absolute Number
ReqIF.ForeignCreatedBy - Created By
ReqIF.ForeignCreatedOn - Created On
ReqIF.ForeignCreatedThru - Created Thru
ReqIF.ForeignModifiedBy - Last Modified By
ReqIF.ChapterName - Object Heading
ReqIF.ChapterNumber - Object Number
ReqIF.Name - Object Short Text
ReqIF.Text - Object Text
ReqIF.Description - Description
Supplier_Description - Customer_Description
Supplier_Status - Customer_Status

Example of a WordToReqif mapping file

ID | ReqIF.ForeignID | integer
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Heading | ReqIF.ChapterName | text
Text | ReqIF.Text | text
Customer_Desc | Supplier_Descr | text
Release Date | Release Date | date: dd.MM.yyyy
Price | Price | real: .

Example of a REQXML to ReqIF mapping file

Last Modified By - ReqIF.ForeignModifiedBy
Object Heading - ReqIF.ChapterName
Object Number - ReqIF.ChapterNumber
Object Short Text - ReqIF.Name
Object Text - ReqIF.Text
Customer_Description - Supplier_Description
Customer_Status - Supplier_Status

REQXML
This is a simplified custom XML format to speed up data exchange to ReqIF format. Read

here the [3]REQXML documentation.

Output files
If the target type is ReqIF or ReqIF DNG, there will be only one output file (reqif or reqifz)
If the target type is single Spec RIF, there will be only one output file (xml or zip)

If the target type is multi Spec RIF, there will be one output file for each Specification (xml

or zip); the file names will contain the names of the specifications

Logging
For each batch operation, an entry will be added to the logfile. Each entry will contain the
date and time of the operation, the input and output file(s) path and names, the output
file(s) type and the job ID.
If an error occurs during the operation, the report will include an exit code and message.
You can see the complete list of exit codes and messages below.
General Exit Codes 5 Batch Feature ID is missing
10 Error during Conversion
20 Mandatory Parameter "batch" is missing
21 Mandatory Parameter "in" is missing
22 Mandatory Parameter "out" is missing
23 Invalid output type value
24 Job id can not be empty
25 Has invalid parameter
26 Incompatible output type value

Input File Related Exit Codes 110 Input File is not readable or does not exist
120 Input File has not defined type (Autodetection fails)
130 Input File is not valid (Schema validation fails)
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Output File Related Exit Codes 210 Not enough space in output folder (3*size of input file
required to be free)
220 Outputfolder is not writable
240 Output folder does not exist

Mapping File Related Exit Codes 310 Mapping file does not exist or is not readable
320 Mapping file has wrong format

Log File Related Exit Codes 410 Access denied; Cannot create not existing log file on
creation mode
411 Access denied; Cannot write to existing log file on update mode

1. https://documentation.reqteam.com/reqxml-to-reqif/
2. https://documentation.reqteam.com/reqxml-to-reqif/
3. https://documentation.reqteam.com/reqxml-to-reqif/

ReqEdit supply chain (2021-07-26 10:57)

Use ReqEdit in your supply-chain to minimize data loss and risk factors. Give your suppliers
the possibility to use ReqIF requirements with our software.
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ReqEdit Supply Chain solution package including ReqEdit Ultimate on the Manufacturer side

and ReqEdit Supplier edition on the Supplier side, diagram illustrates the data exchange

between the participants with recommended actions

The package

ReqEdit Ultimate

Starting from 5 network licenses

Internal use within the company

All add-ons are included

ReqEdit Supplier edition

Unlimited licenses

External use by suppliers

Can only fill in specific data

ReqEdit supplier edition
128



ReqEdit can be branded and distributed to suppliers. Licensing terms and conditions can
be configured to accommodate different use cases.

Branding

The main content area of the application can display your logo image, and on the bottom
license area the company name can also be included.

ReqEdit branding areas highlighted

Licensing

Whitelabeling uses only a time limited license without locking to a specific machine.
Specific license text can be included to represent the usage terms and conditions for the
supplier.

Promoting ReqIF format
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As your company grows and the requirements are more and more sophisticated, lossless
data transfers are a key factor to minimize communication errors and production delays.

Some of the benefits of using ReqIF format include:

Structured data

Lossless data exchange

Traceability

Lossless data round trips between tools

Suppliers can participate in this data exchange easily by offering ReqEdit to them.

Quick start guide (2021-07-27 14:00)

1. Download ReqEdit

Read how to [1]download ReqEdit trial and how to install and start it.

For the purchased product you get downloading and installing details by email from the

sales department.

2. Install ReqEdit

130



First check the [2]system requirements for the ReqEdit application.

Run the Portable-Installer from the directory, you downloaded it. The Portable-Installer
guides you through the installing process.

For trial the activation happens automatically.

Read more on [3]Install ReqEdit.

3. Activate ReqEdit for purchased version

The License activator window appears. In the text box enter the Product key and press the
Activate button.

Note: You need to have non-restricted Internet acces, or need to configure the proxy
settings for it.

For overall view for activating methods, read [4]here.

4. Run ReqEdit

For run use the desktop icon or start "reqedit.exe" directly from the installation directory.

5. Use cases

• [5]Create document

• [6]Open document
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• [7]Import IBM Rational DOORS© RIF Files

• [8]Import MS Word to ReqIF

• [9]Import MS Excel to ReqIF

• [10]Print opened document

1. https://documentation.reqteam.com/reqedit-demo/
2. https://documentation.reqteam.com/starting-reqedit/#System-Requirements
3. https://documentation.reqteam.com/starting-reqedit/#Installation
4. https://documentation.reqteam.com/licensing-models/
5. https://documentation.reqteam.com/?p=2163
6. https://documentation.reqteam.com/open-reqif-requirement-files/
7. https://documentation.reqteam.com/importing/
8. https://documentation.reqteam.com/importing/#MS-Office-Word-Import
9. https://documentation.reqteam.com/excel-importer-add-on/
10. https://documentation.reqteam.com/printing/

1.2 August

Document Settings (2021-08-03 14:06)

Before describing the document properties, lets go through the internals of the ReqIF files.

TLDR jump to Document properties

Attribute types

Each specification document has its own set of attribute types that are used as attributes.
The list can be displayed using the menu Settings > Document.

Automatic data types for documents
Each new document will have: integer, real, date, string, xhtml and boolean attribute types
automatically created, which can be edited.
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ReqEdit displaying list of attribute types of a specification document, highlighted is the

data type column which displays the base type and restrictions of the attributes. Selected

is an enumeration type attribute and the enumeration values are displayed on the right

bottom in the Enumeration Type Values list box

Data types

Attributes in ReqIF files are constructed from underlaying data types with or without restric-
tions. The usage of restrictions in the data types can make the requirement specifications
more robust by not letting invalid values to be used.

Properties of data types

Depending on data types, different properties are available. The following table describes
all available properties per data type
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Long Name Description Min Max Accuracy Enum Values
Boolean X X
Date X X
Enumeration X X X
Integer X X X X
Real X X X X X
String X X X
XHTML X X

Boolean

Its value can be true of false. These two states are displayed by a check box on the screen.
This is an exception type, double click on the cell is not necessary for editing. Its value can
be altered by a single click.

Date

A real date can be written or set as its value. In the view mode, the cell shows the value of
the date, but in the edit mode it displays the DateTimePicker controller used for selecting
the date. This offers help for the user to select fast the exact date. The date value can also
be removed by unchecking the box in the top left corner of the date picker.

Integer

An integer can be given as a value between previously determined limits. In case of not
giving a numeric type, the program will display an alert and the user can only continue if a
correct value is entered.

Real
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The value can be a decimal number between previously determined limits. In case of not
entering a numeric type, the program will display an alert and the user can only continue
if a correct value is entered.

String

An unformatted text with a previously determined length can be entered as a value.
NOTE: The maximum allowed length of a string is 600 characters. This limitation was
imposed in order for the files to be compatible with IBM Rational DOORS.

Enumeration

Represents a list of fixed values that can be used.

Each value has a Numeric Value, a Label displayed to the user, and an optional color in
HEX or named color.
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Enumeration type editor window

XHTML

XHTML format permits formatting of text in multiple ways, similar to any text processing
application: Bold, Italic, Underline, Strikethrough, Superscript, Subscript, Unordered list,
Ordered list, Paragraph, Normal text, Heading 1 – Heading 6

In addition to text formatting tables and images can be used in the content, as well as file

attachments.

Attributes
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Using the defined attribute types, attributes can be created to be used in the document or
the objects. Each data type has its own properties shown in the following table

Long Name Description Read Only Multivalued Default Value
Boolean X X X X
Date X X X X
Enumeration X X X X X
Integer X X X X
Real X X X X
String X X X X
XHTML X X X X

Enumeration attributes

Using enumeration data types in attributes has two main use cases

Single-value enumeration

You can choose only one value from a previously determined value set. It shows the chosen
value in cell viewer mode. In the editor mode you can choose the required value from a
values list (ComboBox or DropDownList).
Besides the values of an enumeration attribute type, the user can also select the value to
remove the value of a cell.

Multivalue enumeration

You can choose multiple values from a previously determined value set. It shows the
chosen value in cell viewer mode. In the editor mode you can choose the required values
from a list by selecting each check box.
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Multivalued enum attribute displayed as list of values with colors

Single value enum attributes are displayed as text
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Document Properties

Information related to a specification document is visible in the Document tab. Document
Name, description, attributes and statistics.

Statistic Information of:

• Documents in file

• Rows in selected document

• Attributes in selected document

• Attribute types in selected document

• Incoming and outgoing links

Attributes that are defined internal to the specification are also listed with the value
displayed on the right side.
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ReqEdit displaying document properties

Specification types

Currently not displayed, internally will be created and used exactly as in the ReqIF standard.

Object Attributes

List of attributes used in all objects of the selected document.
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Object Attribute management window

System attributes are displayed by a PC icon in the list, these attributes cannot be deleted

ReqEdit internal attributes

• ReqEditID – integer type, read-only attribute, internal unique ID

• ReqEditModifiedOn – date type, read-only attribute, last modification date of the object

• ReqEditModifiedBy – string type, read-only attribute, stores the Windows username
who edited the object

SpecObject types

Currently not displayed, internally will be created and used exactly as in the ReqIF standard.
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Links

Are covered in the [1]Links chapter

1. https://documentation.reqteam.com/chapter/links/

Add-on for Weak-word analysis (2021-08-20 14:43)

Weak words are words that are confusing for readers and should be avoided if possible.

This tool provides a case insensitive whole word search for this purpose, optionally writing

the results back in the ReqIF file.

Analyze weak words

Start ReqEdit and open any ReqIF file. Select the specification document that needs to be
analyzed. Select Add-ons > Weak Word Analysis.
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ReqEdit Weak Word Analysis tool window

Language selector – displays the configured dictionaries from the ReqEdit.exe.config file

Write status – update a specific enumeration attribute if there is or not a match in the
dictionary

NOTE: Write status for multi value enums will add the selected value, existing values will
not be removed. This can be useful for status fields that are used for other markings as
well.

Write match log – update an XHTML attribute with the analysis result, optionally overwriting
the contents in the selected attribute

Log "no match" - write in the attribute when no match is found
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ReqEdit weak word analysis progress window and log

Analysis progress and log is displayed in real-time. After completion the log output can be
saved as a file with [Save log to file] button

Analysis result in ReqIF

When Write match log is enabled, the ReqIF file will be updated with the current results of
the analysis.
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Weak word analysis tool result attribute on the right side

Expert knowledge

Dictionary

Dictionary file/s must be created in the ReqEdit/Dictionary folder and has to follow the
following format:
<Lowercase word><TAB><hint>

should Strong Weakword; should be avoided, please choose another wording.
about Strong Weakword; should be avoided, please choose another wording.

Only one word per row.

NOTE: If the hint is not present the analysis still works but the report will be empty for it.
Dictionary config
Edit ReqEdit.exe.config and set the WeakWordList to use the dictionary files
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<setting name="WeakWordList" serializeAs="String">
<value>Deutsch,weakword_list_de.txt;English,weakword_list_en.txt</value>

</setting>

The dictionary files has to be added in the following format:
<Language selector label>,<dictionary file name in Dictionary folder>;
There must be at least one dictionary to use the tool. The dictionary should be saved in a
text file with UTF-8 encoding.
Only Main Column is used for analysis other attributes are not processed.
Dictionary contents is filtered and only unique word+hint pairs are used.
The tool is searching only for whole words in the Main Column contents.
The search is case insensitive regex search.
All text is converted to lowercase internally and matched with the lowercase weak words.
Weak word Text Result
go I will GO TO THE office then go home 2 Found
go John goes to the office Not found

Status updates
Single value enumeration attributes will have the value from the configuration.

Multi value enumeration attributes will receive the configured values, but the previous val-

ues will not be removed from it.
Notices and limitations
If the weak word add-on menu is not active it can have several reasons:

• You do not have the necessary license

• There are no ReqIF files opened

• ReqEdit.exe.config is not configured

The tool was tested in UTF-8 character encoding, using other encodings can produce unin-
tended results.

XML Editor add-on (2021-08-23 13:50)

ReqEdit XML Editor is optimized for ReqIF files. Supports XML validation as well as ReqIF

schema validation.

Opening the XML Editor
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Select Add-ons > XML Editor

ReqEdit XML Editor add-on, displaying a single ReqIF file

The editor can display multiple ReqIF files in tabs. In the lower part of the interface is the

validation / debugger panel.

Validating ReqIF

The editor supports validation for ReqIF / RIF1.1a using the document type toolbar section.
After validation the errors will be displayed in the debugger panel.

ReqEdit XML Editor add-on, displaying validation errors
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ReqXML to ReqIF (2021-08-23 14:37)

Simplified XML format for generating ReqIF files with ReqEdit. The XML schema defines

that all XML tags MUST be UPPERCASE and all HTML tags MUST be lowercase.

ReqXML Format

The namespace defined for ReqXML is http://www.reqteam.com/reqedit/data-exchange .

Example of a ReqXML file

<EXCHANGE-DATA xmlns="http://www.reqteam.com/reqedit/data-exchange"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.reqteam.com/reqedit/data-exchange
file:///D:/Work/ReqEdit/RifSchemas/reqedit_xml/reqedit_xml.xsd">

<METADATA>
<DOCUMENT-TYPES>...</DOCUMENT-TYPES>
...
<ITEM-TYPES> ... </ITEM-TYPES>
...

</METADATA>
<DOCUMENTS>

<DOCUMENT>
...
</DOCUMENT>
...

</DOCUMENTS>
</EXCHANGE-DATA>

Document types - Defines attribute sets for requirement documents

Item types - Defines attribute sets for the requirement objects inside the document.
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NOTE: only one item type is supported for one document (multi item type documents are

not supported)

Type definition

<ITEM-TYPE>
<ID>_a23fe234-236f-45e5-b321-2342117348</ID>
<NAME>All attributes</NAME>
<ATTRIBUTES>

<ATTRIBUTE-STRING>
<NAME>RequirementsID</NAME>

</ATTRIBUTE-STRING>
<ATTRIBUTE-XHTML>

<NAME>ChapterName</NAME>
<BASETYPE>

<ID>_8a711c80-1594-48ba-b850-4855a768e5b3</ID>
<NAME>HTML-TEXT2</NAME>

</BASETYPE>
</ATTRIBUTE-XHTML>
<ATTRIBUTE-ENUM>

<ID>_7e9ac904-9c20-4a97-8d73-535cd189212e</ID>
<NAME>ObjectType</NAME>
<MULTIVALUE>false</MULTIVALUE>
<VALUES>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Heading">Heading</VALUE>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Information">Information</VALUE>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Requirement">Requirement</VALUE>

</VALUES>
</ATTRIBUTE-ENUM>

</ATTRIBUTES>

In the example we defined:

• string attribute with name: RequirementID, For a single import is this enough.

• XHTML attribute with name: ChapterName.

• Single Enum attribute with name: ObjectType with values: Heading, Information, Re-
quirement

Document structure
One file can contain multiple documents. Each of the documents must have a reference to
the attribute set, which defines the attributes of the document itself. Even if there are no
attributes a document type reference needs to be done. Additionally, a NAME need to be
defined.

<DOCUMENTS>
<DOCUMENT>
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<ID>_3_f7e0655f-2099-40fe-bfbc-08346abda405</ID>
<PARENT>_1_f7e0655f-2099-40fe-bfbc-08346abda405</PARENT>
<NAME>FOO</NAME>
<DOCUMENT-TYPE-REF>_a23fe234-236f-45e5-b321-document</DOCUMENT-

TYPE-REF>
<ITEMS>

<ITEM>
<ITEM-TYPE-REF>_a23fe234-236f-45e5-b321-2342117348</ITE

M-TYPE-REF>
<ATTRIBUTES>

<ATTRIBUTE>
<NAME>ChapterName</NAME>
<VALUE>

<div
xmlns="http://www.w3.org/1999/xhtml">First main chapter.<em>ss</em></div>

</VALUE>
</ATTRIBUTE>

</ATTRIBUTES>
</ITEM>
...

</ITEMS>
</DOCUMENT>
...

</DOCUMENTS>

Each of the items need to have a reference to an item type which determines the attributes
can be used in this requirement and an unique ID for later trace or structure references . To
define the attribute reference, use the NAME tag and to set the value the VALUE tag, except
the enum attributes.
Enum values always needs to be inside VALUES tag. Even if the Enum is single valued.
<VALUES><VALUE>Heading</VALUE></VALUES>

To build up a tree structure inside the document, it is possible to define parent items (tag

PARENT). The value of the tag is the unique ID of the parent item/requirement.

Attribute Types
To define an attribute, you must define a name (NAME tag). Optional you can define an
unique ID (ID tag) and a default value (DEFAULT tag). The IDs need to be unique in the
complete document and need to be of type XSD:ID ([1]https://www.data2type.de/xml-xslt-
xslfo/xml-schema/datentypen-referen z/xs-id/)
Attribute types allowed in ReqXML Type XML Tag Notes
Boolean ATTRIBUTE-BOOLEAN
Integer ATTRIBUTE-INTEGER Optionally
Minimum (Tag MIN)
Maximum (Tag MAX)
Real ATTRIBUTE-REAL
Date ATTRIBUTE-DATE Date format:
2020-07-23T23:59:59
String ATTRIBUTE-STRING Text without any formatting or line breaks
XHTML ATTRIBUTE-XHTML Supports line breaks, formatting or attachments
Enumeration ATTRIBUTE-ENUM Multivalued Enums (Tag MULTIVALUE with value true / false)
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Each attribute needs to refer to a predefined attribute type. For enumerations the valid
valued need to be defined

<ATTRIBUTE-ENUM>
<ID>_7e9ac904-9c20-4a97-8d73-535cd189212e</ID>
<NAME>ObjectType</NAME>
<MULTIVALUE>false</MULTIVALUE>
<VALUES>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Heading">Heading</VALUE>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Information">Information</VALUE>

<VALUE
ID="_7e9ac904-9c20-4a97-8d73-535cd189212e-Requirement">Requirement</VALUE>

</VALUES>
</ATTRIBUTE-ENUM>

XHTML Attributes
For formatted content please use attributes of type XHTML. All content MUST be wrapped
in a div tag

<div xmlns="http://www.w3.org/1999/xhtml">My formatted ... content</div>

NOTE: The div wrapping is necessary to be able to validate the XHTML content internally.
Limitations
Please keep in mind, that ReqXML is only a preformat for the ReqIF, which does not allow
all tags from XHTML. So ReqXML allows only tags which are valid in ReqIF, too.
So please use only the basic formatting tags (like cite, em, strong, sup, sub ..) and the
predefined heading tags (h1..h6). You can use XHTML Tables and list elements (Tags OL and
UL) as well.
In a requirement document the requirements will be linked completely, and not only some
words (like in XHTML with the A tag). Please use for tracing definition the link tag of ReqXML
to reference between requirements (artefacts)
If you want to reference to external files, please do it only with the tag OBJECT and not with
IMG (which is not allowed). Attachments of a single document should be placed in a definite
subfolder (which is named like the document itself or its ID).
<object data="./attachments/Anschreiben.docx" type="application/word">
<object data="./attachments/Anschreiben.png" type="image/png">this is an alternative
text</object></object>
It is recommended to create for each of the attached files a small preview, so the require-
ments engineer could have a quick impression about the content inside the file. Previews
has to have PNG format!

For more advanced users, which are already experience with XML Schema the list of valid

tags can be traced down in the XML Schema file located at ReqEdit in the folder <<PATH to

REQEDIT>>ReqEdit\RifSchemas\reqif\ driver.xsd and referenced schema files inside.
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Relevant ReqIF attribute naming
If you want to use your data in Requirement Management systems or want to have a cor-

rectly display the data in ReqEdit, please use the following naming conventions: Attribute

Name Type Description

ReqIF.ChapterName XHTML Requirements heading

ReqIF.Name XHTML Short description

ReqIF.Text XHTML Requirements text

ReqIF.ForeignDeleted BOOLEAN Display this item as deleted if set to true

ReqIf.ForeignID INTEGER ID given by the source RM system

ReqIF.ForeignCreatedBy STRING User that created this item

ReqIF.ForeignCreatedOn DATE Date the item was created

ReqIF.ForeignModifiedBy STRING User last modified the item

LAST-CHANGE attribute of item DATE Modification date of the item

ReqIF.ChapterNumber STRING The chapter number

Best practices
• Please avoid defining a heading and requirements text in one item/requirement.

• Use only headings as structuring element, if its possible

• Please use long IDs (preferred UUIDs) for the unique IDs, so the chance is low to have
the same ID for two elements in your complete project.

• Don’t use the same attribute names inside the same type definition

• Don’t use the same value inside the same Enum definition

IBM specific SAME-AS mapping
DOORS Next support the possibility to define different attributes for different documents,
but the meaning of the attribute is identic. To avoid creating multiple instances of the same
attribute it is possible to determine a SAME-AS tag with an URL content, that says to DNG
not to create the attribute multiple times. This definition needs to be done in the document
types or item types definition of the specific attribute

<ATTRIBUTE-DATE>
<NAME>LastModified</NAME>
<SAME-AS>http://purl.org/dc/terms/modified</SAME-AS>

</ATTRIBUTE-DATE>

Updates
If you plan multiple imports of the same document for updates, it is recommended to fix
down the Attribute Ids and the referred base type. These values will be stored in the RM
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system (like DOORS or Polarion) and could be later updated easily. To do so, please define
for each of the attributes a unique ID.

For Enum values (Tags VALUES) please define the valid values (Tag VALUE). The definition

of unique IDs is only necessary if you plan an update import.

Traces
It is possible to define links between the different items (not necessarily in the same docu-
ment, but in the same file). The block LINKS should follow the ATTRIBUTES tag inside the
item/requirement.

<LINKS>
<LINK-TYPE NAME="verification">

<LINK TARGET="abc" DOCUMENT-REF="REQ-q23" />
<LINK TARGET="def" DOCUMENT-REF="REQ-q23" />

</LINK-TYPE>
<LINK-TYPE NAME="satisfies">

<LINK TARGET="abcd" />
</LINK-TYPE>

</LINKS>

The reference to the document is not necessary, if the ID can be identified in the file. The
attribute TARGET holds the unique ID of the target item. The Attribute DOCUMENT-REF is
the unique ID of the document, where the item ID should be in.

1. https://www.data2type.de/xml-xslt-xslfo/xml-schema/datentypen-referenz/xs-id/

1.3 December

License Management (2021-12-16 10:45)

Automatic activation.

Activation runs automatically for trial version or for some custom-tailored versions.

On the last step of the installer the checkbox remains at default settings.
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Window Start Activation Setup

LicenseActivator.exe starts without displaying User interface. It detects .v2c file and
activates the product.

ReqEdit opens automatically.

Online activation

After installation

Note: You need to have non-restricted Internet acces, or need to configure the proxy
settings for it.

The License activator window appears. If not, run the LicenseActivator.exe in the ReqEdit
folder. In the text box enter the Product key and press the Activate button.
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Diagram of public environment with direct connection to ReqEdit License Server
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License activator window

Activation done
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Activation done. Run ReqEdit.

Offline activation

This activation allows running ReqEdit when access to ReqEdit License Server is restricted
or not available. Create manually a license for the machine where ReqEdit is running.

In this case there are 2 options for activation: Activation with the file LicenseActivation.exe
or Activation using the RUS Tool. Through them you can generate a .c2v file which you
need for creating the license for your PC.

Activation with LicenseActivation.exe
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Activation with RUS Tool

Activation with [1]LicenseActivation.exe

Activation with [2]RUS Tool
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Activate with LicenseActivation.exe

The offline activation needs the following:

• product key (got with purchasing ReqEdit)

• machine generated .c2v file (follow the next steps)

Open ReqEdit folder and click LicenseActivation.exe in the ReqEdit folder.

Pops up License activator window. Here generate C2V file

Save the file into the suggested folder or elsewhere

Generate c2v file in Offline activation
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At an online workstation login with Product key at the Sentinel EMS Customer portal

[3]https://license.reqteam.com/ems/login.html

Sentinel EMS Login

Choose Offline Activation tab. A new window appears.

In the Generate License window upload the saved C2V file.

Then click Generate.
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Uploading the .c2v file

The Key ID. appears

Download the VC2 file

Downloading the V2C file

Go to the License Activator window and press Activate button
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Activate offline with key

In the Browser window select V2C file

Press Open
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Open ReqEdit and start working with it.

Activate with RUS Tool

• Login to the customer page of REQTEAM license management
([4]https://license.reqteam.com/ems/customerLogin.html)

• Enter your license key from your license
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Sentinel EMS login

Click on the Offline Activation Button

Appears Generate License window

Download RUS tool
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Download RUS tool (RUS _OWOZQ)

Some antivirus program can delete or quarantine this file. So, keep it when the antivirus
asks for deleting or putting into quarantine.
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Keep RUS tool

1. execute RUS tool

2. select Collect Status Information and select C2V file type.

3. select Installation of new protection key

4. press Collect Information

5. save the C2V file
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Generate c2v file
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Save c2v file

C2V file can be used for license related operations.

At an online workstation login with Product key at the Sentinel EMS Customer portal

Upload the C2V file to [5]Sentimel EMS.
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Upload c2v to EMS

Press Generate to generate V2C file.

Download V2C file to your PC.

Download v2c

1. execute RUS Tool

2. select tab Apply License File and select the V2C file

3. press Apply Update to activate the license on the machine
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Apply update V2C
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Activation done

Activation done!

You can start to work with ReqEdit.

Network license server ACC

A self-hosted licensing server is installed on the restricted network. The server holds all
the license pools that can be used and has to contain a current snapshot of the license
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database from ReqEdit License Server.

Downloads

Download haspdinst.exe for windows

Version Downloads
Sentinel ACC haspdinst.exe 8.31 [6]haspdinst.zip [7]haspdinst.exe
ACC windows versions

Download aksusbd.tar for linux

Version Downloads
Sentinel ACC aksusdb.tar 8.31 [8]aksusbd-8.31.1.tar
ACC linux versions

Add note: please inform REQTEAM if you plan to use detaching, so the license can be
generated for this purpose.

Installing
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Diagram of restricted environment with self hosted ReqEdit License Server

NOTE: The installation needs to me made on the "future" license server.

NOTE: Windows can detect the haspdinst.exe as untrusted, Run Anyway

• Port 1947 has to be opened

• Type haspdinst -i in the command line. The installation or upgrade process is performed
automatically. A message is displayed informing you that the Sentinel LDK Run-time
Environment was successfully installed.
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On windows execute the following command to start the installation:

haspdinst -i

You can find an extended manual if you run the program in Windows File Explorer.
To check the status of the installation execute the command:

haspdinst -info

The version of the "Installed Package Drivers" needs to be 8.31
To check the status of the installation execute the command
haspdinst -info
In the ReqEdit application folder you need to start the executable "Start.exe" or "LicenseAc-
tivator.exe" depending on the version you have and insert the FQDN or IP of your license
server.

Read more on the topic here [9]Installation guide Thales/Sentinel LDK EMS
Updating
The update of the ACC needs to be done exactly like the install.
Fist stop the windows service (press windows START then type "Services") with the name
"Sentinel LDK License Manager" and then execute

haspdinst -i

Uninstalling
To remove Sentinel license server on Windows execute

haspdinst.exe -r

if for some reason the uninstallation does not work, you can force remove with

haspdinst.exe -fr

Configuration
C2V on Windows
Go to the license server webpage [10]http://localhost:1947 and select the "Sentinel Key"
item.
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ACC server showing the vendor keys, download the Fingerprint

press the "Fingerprint" button and save the C2V file in the downloads folder.

Step 1: Got to the customer login page [11]https://license.reqteam.com/ems/customer-
Login.html. You need to insert the product key to login.

Login Sentinel EMS

Step 2: Select "Offline Activation".

Step 3: Upload the created .c2v file.

Step 4: Click the "Generate" button and save the .v2c file to a folder you like.

Upload c2v file

Update/Attach licenses
Step 5: Download the generated V2C file (or the V2C file received from us)
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Download V2C file
Step 6: Upload to your local license server [12]http://localhost:1947 in the menu "Up-
date/Attach".

ACC server update/attach V2C license file page
Step 7: Check in in the menu "Products", if the license was correct inserted/updated.
C2V on Linux
If you are using Linux, the procedure is a little bit more complex. You need to log in to
your license server (ACC) and click the tab "Diagnostics". Here you find a button named
"Generate ID File". After clicking this button you got an ID file to save. Please save this file
to a local drive and change the file extension to .c2v.
Now open this C2V file in a text editor and change the structure of the ID file, which should
look like this (characters truncated with ...):

<?xml version="1.0" encoding="UTF-8" ?>
<location>
<license_manager id="F07reQmW9igotxo.....1b4VD5kRUi4qsA" time="0">
<version>24.4.1.110802</version>
<hostname>safenet</hostname>
<name>SAFENET</name>
<host_fingerprint type="SL-AdminMode" crc="123456789">
MXhJSYlJIQewwFkjBPbITRjkSqpKZebAq3PcANCwG............==
</host_fingerprint>
</license_manager>
</location>
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and change the file to this:

<?xml version="1.0" encoding="UTF-8" ?>
<hasp_info>
<host_fingerprint type="SL-AdminMode" crc="123456789">
MXhJSYlJIQewwFkjBPbITRjkSqpKZebAq3PcANCwG............==
</host_fingerprint>
</hasp_info>

License detaching
Note: please inform REQTEAM if you plan to use detaching, so the license can be generated
for this purpose.
When users want to have a working copy of ReqEdit outside the restricted environment.
License detaching is possible by using the Detach Tool Add-on.
Detaching licenses will lock the license for a period of time for a specific machine. Locking a
license has to be done inside the restricted environment, after which it can be disconnected
from the network.

Diagram showing detach mechanism to work outside network license server
NOTE: : To be able to use ReqEdit on a workstation which leaves the company network, you
need to detach a license for it. To achieve this goal ACCmust be installed on the workstation!
Installing ACC on the workstation (jump to ACC install section)

Configuration of ACC is not needed. Detach tool will handle the license transfer automati-
cally.
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Requirements
The ReqEdit Detach tool needs to run on a Windows operating system with .Net library (at
least version 4.8 or higher) installed.

Additional the Sentinel Admin Control Center needs to be installed and configured locally.
Please ensure that a valid VLIB DLL (i.e. haspvlib _113498.dll is corresponding for ReqEdit
licenses) is installed. The file needs to be in the folder.

“C:\Program Files (x86)\Common Files\Aladdin Shared\HASP”.

About detailed requirements, read more [13]here.

Enable Detaching on main server
Before you detach a license, you need to make configurations on the server in order to
enable detaching on your main server

To do that you need to login on the ACC license server and select the menu “Configuration”
and select the tab “Detachable Licenses”

1. Allow Remote Access to ACC as HTTP or HTTPS

2. Set Password

ACC server configuration for HTTP or HTTPS access

3. Go to the Detachable Licensing Tab

Please activate the checkbox “Enable Detaching of Licenses”. You can determine the maxi-
mum detach duration in days.

Additional you can set the number of licenses you want to keep on the server (to be not
detachable) in the field “Reserved Licenses”. Here you can enter either an absolute number
or a percent value. .

If you want to do different settings for your different products, you can do this by click on
the button “Per-Product Settings”.
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ACC Detach license tab
Configure Detach tool
The tool has to be configured on the workstation
Open Reqedit\AddOn\Lm\ReqEd itLm.exe.config

ReqEditLm.exe.config location in Windows Explorer
Set server address to the ACC server
serverAddress - 10.0.0.10 or the FQDN like: server.localdomain.local
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...
<setting name="LicenseServerAddress" serializeAs="String">
<value>server.localdomain.local</value>
</setting>
...

Generate config.dat

reqeditlm.exe -pass password -out config.dat

password - the access password for ACC server (that was set in the previous steps)
outfile - config.dat the file that will be used in the config xml

NOTE: If you want to use different out file please update the xml to use that

To use the Detach Tool please open [14]Users Guide

License Updates
If your license is arriving the expire date or even some days before we will provide you an
update key (file ending .V2C) and you request a new one.

A. You do not have a license manager installed (no ACC)

You need to activate this license with your "LicenseActivation" tool from ReqEdit client. Se-
lect offline activation and press the "Activate" button and select the V2C File to update your
license.

Update License window

At an online workstation login with Product key at the Sentinel EMS Customer portal

[15]https://license.reqteam.com/ems/login.html
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Sentinel EMS Login
Choose Offline Activation tab. A new window appears.
In the Generate License window upload the saved C2V file.
Then click Generate.

Uploading the .c2v file
The Key ID. appears
Download the V2C file

Downloading the V2C file
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Go to the License Activator window and press Activate button

Activate offline with key

In the Browser window select V2C file

Press Open
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License activator window, offline activation tab, license activation success

Open ReqEdit and start working with it.

B. You have a license manager installed and you don’t have a V2C file

Alternatively you can update automatically if you have installed a license server (Admin Con-
trol Center in the minimum version 8.31) on the computer that holds the license. You need
to open the url [16]https://license.reqteam.com/ems/customerLogin.html on this computer
and click license update.

EMS Login

C. You have a license manager installed, but with no or restricted internet acces

Login to Sentinel EMS Customer Portal. Open the url
[17]https://license.reqteam.com/ems/customerLogin.html and enter Product Key.
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Sentinel EMS Login

Upload the C2V file to Sentinel EMS. Press Generate for generating v2c file.

EMS C2V file upload

Download the generated V2C file.
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Download V2C file

Upload the generated .v2c file to your local server ACC in the menu "Update/Attach".

ACC server update/attach v2c file

Transfering License

To transfer an user license from an old PC to a new PC you need the RUS tool on both PCs.
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License transfer diagram between two machines

Download RUS Tool

You can download it from our customer area:

[18]https://license.reqteam.com/ems/customerLogin.html

For login you need to enter your product key, use the key you already used for activation.

After login you click on Offline Activation button and download the RUS tool.
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Download RUS tool

Generate ID file

IF YOU USE ACC (LICENSE SERVER)

For transfering License from a Network license server to another , you need to have a Re-
hostable license.

Open ACC on the new server to generate the ID file

Go to Diagnostics of your license server and click on "Create ID file" button on the top right
of the page
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Generate ID file for license transfer
Save the file generated.
IF YOU DON’T USE ACC (LICENSE SERVER)
Execute the RUS tool on the new PC, where you want to have the license transferred. Select
the Transfer License tab. Please press on the [...] button to select the location and choose
a name for the Recipient Information ID file (the name of the file is not important).
Press Collect and Save Information to generate the file. If the process was successful, you
will get a confirmation window.

Generate ID file
Copy the generated Recipient ID file to the old PC, where the active license is.

Please do not close the RUS tool on the new PC, we need it for later.
Generate license transfer file
Run the RUS tool on the OLD PC.
Select the Transfer License tab. Check if your license is transferable, it has to be listed in
the license list.
Note: If the license is not transferable you need to contact the REQTEAM support team to
initiate a manual transfer.
Note: if you use ACC you need to have Rehostable license.
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Rehostable license icon for ACC user

Select the license you want to transfer from the list

Select the Recipient Information ID file copied from the NEW PC.

Select the destination of the Transfer License File, by selecting the [...] button. Press Gen-
erate License Transfer File button.

The .h2h file needs to be copied to the NEW PC.

Generate license transfer file

You can close the RUS tool on the OLD PC.

Activate license transfer file
IF YOU USE AN ACC (LICENSE SERVER)

Upload the generated H2H file in your new ACC in the menu "Update/Attach".
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Attach the h2h transfer license file

IF YOU DON’T USE ACC (LICENSE SERVER)

On the NEW PC in the RUS tool select Apply License File.

Press the [...] button to select the .h2h transfer license file and press Apply License.

The output should look similar to the screenshot.
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Transfer successfull
1. https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe
2. https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool
3. https://license.reqteam.com/ems/login.html
4. https://license.reqteam.com/ems/customerLogin.html
5. https://license.reqteam.com/ems/customerLogin.html
6. https://cloud.reqteam.com/downloads/thales/8.31/haspdinst.zip
7. https://cloud.reqteam.com/downloads/thales/8.31/haspdinst.exe
8. https://cloud.reqteam.com/downloads/thales/8.31/aksusbd-8.31.1.tar
9. https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/Install/Installation%20Guide/RTE_using_Utility/haspd
inst.exe%20Utility.htm
10. http://localhost:1047/
11. https://license.reqteam.com/ems/customerLogin.html
12. http://localhost:1947/
13. https://documentation.reqteam.com/starting-reqedit/#System-Requirements
14. https://documentation.reqteam.com/license-detach-utility/
15. https://license.reqteam.com/ems/login.html
16. https://license.reqteam.com/ems/customerLogin.html
17. https://license.reqteam.com/ems/customerLogin.html
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18. https://license.reqteam.com/ems/customerLogin.html
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2. 2022

2.1 February

Create document in REQEDIT (2022-02-14 11:12)

ReqEdit creates different types of requirement documents.

• New specification (.reqif)

You can create a new specification document withouth attachements.

• New specification with attachements (.reqifz)

You can create a new specification document with attachments, images, file attachments
based on ReqIF format from default or template. This option is recommended to use, vs
the simple reqif documents.

More about ReqIF formats read [1]here.

ReqIF (.reqif) ReqIF Archive (.reqifz)

No attachments Can have attachments

CTRL+N CTRL+SHIFT+N

Create a new specification document
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Dashboard

Create a new specification document:

• Click on the wanted option on the Dashboard or

• Open File menu/New... and choose the option you want to use
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File menu

New Archive

ReqIF Archive supports attaching external images or files to any requirement. Creating a
new archive will show a window asking for a filename.

Choose default template from the Template selector pop-up window.

A new file template appears.
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New Template

An overview of the user interface description, read [2]here.

Adding new items

Now you can add rows, add columns (attributes) to your document.

To add rows click File/Edit/Insert new row ... or Insert new child row

To delete rows click File/Edit/Delete row

To add Column go to [3]Settings/Document or use shortcut key F8

In the Document settings table use Attributes tab to add new or edit or delete columns.
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Document settings

Attribute editor

Note: You cannot edit a created attribute type after saving it.

More about attributes and attribute types read [4]here.

Attachments

ReqIF Archive .reqifz files support having file attachments for objects.

Only XHTML attributes can have attachments inside .reqifz files

Image attachments: png, bmp, jpg, gif, ico, wmf,
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File attachments: any file type is supported: pdf, doc, docx, xls, xlsx …

Inserting file attachments

To add an attachment simply right click the XHTML inline editor area and select Insert
image or Insert file

ReqEdit displaying context menu, highlighted is the insert image and file menu item

ReqEdit displaying attachment previews of an object, contains file icons and preview
images

About editing an opened specification file read [5]here.

Opening existing files, read [6]here.
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1. https://documentation.reqteam.com/reqif-requirements-format/
2. https://documentation.reqteam.com/user-interface/
3. https://documentation.reqteam.com/document-settings/
4. https://documentation.reqteam.com/document-settings/#Attributes
5. https://documentation.reqteam.com/edit-reqif-requirement-files/
6. https://documentation.reqteam.com/open-reqif-requirement-files/

2.2 March

Export to MS Excel (2022-03-31 20:20)

File types you can export to MS Excel with ReqEdit

• ReqIF 1.0.1 to ReqIF compatibility mode

• RIF 1.1 / RIF 1.1a archive format

• ReqIFz

Use case for export to MS Excel option

Use "Excel Export" if you want use an Excel file for:

• KPI determination
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• statistical analysis

• not for reimport changes to ReqIF document

Due to unique column heading ID needed for the export process, the reimported document

can present differences in Attribute names. See [1]Result view

Export to MS Excel

1. Open the document you want to export from.

2. Set the View mode you want in the View menu. It can be predefined or newly set.
Export function will export the datas you can see on the screen by the active view
mode.

3. Open File/ Export...

200



Export wizard

• Follow Export Wizard

• Choose Excel export for reports in the Wizard Window

• Choose name and location for excel file. The Wizard will generate automatically the
ReqIF documents name and adds ’exported’ as excel file name. It can be modified, if
needed.

The export of the ReqIF file will be written in a Excel sheet with the name of the visible
document. If the name is longer than 30 characters, it will be shortened to this maximum
size supported by Excel. If the user choose an existing excel file the sheet with the exported
data will be added or replaced if a sheet with the same name exists.
The message "The file XXX already exists. Do you want to replace it?" generated by the
Windows file selector, can be confirmed with "Yes"; only the tab named after the document
name will be overwritten entirely.

Note: If you want to export a file with an existing excel file name, close the file before click
Start on export to Excel.
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• Check the export options boxes (optionally):

1. ReqIF formatted text export - Exporting data with formatting (only for text, bold,
underlined, strikethrough, italic) Does not support tables, attachments, (limited
support of) lists, background colour.

2. Add meta information to excel worksheet - Exporting meta info based on the View
of the document. It shows the following information in the first rows in the ex-
cel worksheet: export date, file name, document name, document ReqIF-ID, view
name, user name)

Export options

• Finish export. Log info window appear.

• Open the Excel file.
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Finish export window

The numbers in the final export wizard window show the amount of hidden attributes

(columns) or deleted rows in the original document.

Result export view

If you check Add meta information to the excel worksheet checkbox in the Excel export
wizard, the Excel file contains the meta datas in the first rows:

Resulted file view with meta datas

The first 3 columns of the created Excel file contain, independent of the selected View
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mode:

Row Nr Each row is numbered conform to the source specification document.
Hierarchy ID Shows the entry level of the object (text) in the source specification document.
The number shows the chapter number it belongs and after the hash sign ( #) the entry
position in the folder.
ObjectReqIF ID Shows the ReqIF-ID of each object from the source specification document.
New columns in the exported Excel file

These column headings are reseved for the Excel export. They are important to iden-
tify the specifications from the Specification document. If these column names are
defined as attributes inside the ReqIF document, the attribute will be reanamed to
"ReqEdit.<<atributename>>". Ex: RowNr -> ReqEdit.RowNr

The name of the tab in the created Excel file are the first 30 characters of the document
name.

If you reexport a document to existing Excel file, the final file saves the new version of
ReqIF file in the sheet which has the same name. The other sheets /tabs remain the same.

Display of formatted text:

Some elements can be displayed in Excel in a certain mode due to technical limitations:

Formating Display Description
Multi Enumeration multi #1
multi #2
By default any of the multi valued enumeration values will be displayed separated by a
new line.
Unordered list - entry #1
- entry #2 Any of the unordered lists will be displayed as new line separated entries with
an starting dash "-" character for each of the list entries
Ordered list 1. entry #1
2. entry #2 Any of the ordered list entries will be displayed with a numeric value and
followed by a dot
Table [col1][col2]
[col1][col2] Each table column inside of ReqIF-table row will be framed with square bracket
signs
("[ column value ]").
Attachments {"link":"image.png", "type":"image/png" } Textual information about the
linked file and mime type
Attachments with alt text {"link":"image.png", "type":"image/png" }Alternative text
{"endlink" } Textual information about the linked file and mime type
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Limitations in formatting to Excel

Note: Roundtrip Excel-ReqIF is not supported! (You can reimport this Excel file to a ReqIF
file, but you will loose information contained in the original ReqIF).

1. https://documentation.reqteam.com/?p=2386#Result-export-view

2.3 April

Excel importer add-on (2022-04-11 09:42)

Convert a single MS Excel file with XLSX extension to a ReqIF Archive file (.xlsx to .reqifz)

Usage

Start the Excel Importer add-on by selecting Add-ons > Excel add-on.
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ReqEdit Excel importer add-on

Sheet Configuration tab

Step 1. Sheet selection
display the specific sheet to configure, check Ignore Sheet to skip conversion

Step 2. Set header row
select a header row that represent the attributes (table header)

Set import data range
Set the first and last cell coordinate of the converted worksheet section

• Row is row in the excel sheet (1-1048576)

• Column represents the number of column in the excel spreadsheet (A=1, B=2...
XFD=16384)
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Step 3. Configure Attributes (center)

Column represents the number of column in the excel spreadsheet (A=1, B=2...
XFD=16384)

Name represent the Header Row Number from the Set header row section,

To ignore a column from import check the box near

Data type. Tool will try to guess the data types automatically based on the data type of the
first row of the import range.

• Boolean – true/false type values
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• Integer – whole numbers

• Real – decimal numbers

• Date – date format

• String – single line text, no formatting

• Text – multi line text with formatting

• Enumeration – values can be one or more of a fixed set of values in all the rows in
a sheet. Single value if no separator is found. Multi value if separator is found [ , ;
newline ]. The conversion will combine all values found in all the rows within a single
sheet so it can be memory intensive if overused

Note: if the conversion is taking long use Integer ( instead of Real ) and String (instead
of Text types)
For date type it is possible to define a default date, if date is not set in the Excel cell.
To set the Default date please edit "ExcelImport.exe.config" in AddOns/Excel folder. Set
the config value "DefaultDate" to the date you want (format YYYY-MM-DD) and set the
EnableDefaultDate to "True".

Reference Shows the first data from the table

Step 4. Set main column
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Set the type of ReqIF attribute of the imported excel data in the main column

• ReqIF.ChapterName

• Level ID

• ReqIF.Text

Step 5. Set ID field
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To enable round trip, Save first config file

To enable Excel - ReqIF round trip, use Save config and save the config file on your
computer.

To reimport an Excel document you click on Load config with the saved Config file from the
previously saved.

You must select an ID field from the Excel file, if the section is active. The data type of ID
Field must be Integer.

Note: The ID cell must have unique value on each excel workbook, to be possible auto-
matically identification of the specific data row.

Details on the roundtrip: the activation of the Roundtrip configuration forces the applica-
tion to use the stored ReqIF-IDs in the configuration file during the reimport of a "known"
Excel file. So the resulting ReqIF file will have identical IDs for all attributes and data rows.
ReqEdit ReqIF compare will be possible this way and also the import in an external RE tool
will update existing content instead of recreating it.
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Not activating this optional functionality, the new ReqIF file will be generated with new
randomly generated IDs.

Configuration reuse

The tool lets the user save file conversion configurations and reuse them later. This is done

with the SAVE / LOAD CONFIG buttons.

Preview

Preview the data range of each sheet with the configured header row by pressing the EXCEL
SHEET PREVIEW tab.

Best practice

Use the preview to check import settings periodically, the list can be adjusted to show the
start or the end of the range and also the number of the preview rows.
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ReqEdit Excel add-on preview tab

Importing Excel to ReqIF

After the excel file is configured press IMPORT to start the conversion.

The tool will generate a reqifz file near the source xlsx file. All actions are logged.

Output files

Each conversion will overwrite any previous REQIFZ files in the original directory

All generated output is REQIFZ archive format and will be saved near the original document.
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Important Note: please check the content of the imported ReqIF file against your original
Excel! Because of the Excel format we cannot guarantee a loss free import of all data.

Logging

All conversions are logged into the application directory /logs folder. The log files are
splitted into 10mb files and rotated when needed.

The logging uses the log4net library. Experienced users can configure

the file log4net.config to suit the logging needs. Documentation log4net:

[1]https://logging.apache.org/log4net/release/manual/introduction.html

Limitations

Only the XLSX format is supported

Additional content will be discarded (images, charts or any other floating elements)

Marcos are not processed

Pivot tables are not supported

Some formulas are not supported (specially formulas regarding to other cell or table
references or named labels)

Merged cells will be converted to the first cell the merge starts horizontally or vertically

1. https://logging.apache.org/log4net/release/manual/introduction.html
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2.4 June

Merge / Compare Addon (2022-06-25 11:42)

Tool for comparing and merging ReqIF/ReqIFz files. Can be used to compare two versions
of the same file or merge attributes from one specification to another.

Note: the Compare / Merge tool synchronize at startup the settings of ReqEdit about the
HTML validation. To set the HTML Validation status in ReqEdit in the Settings/User menu.
After set the value to the desired, please restart the Compare / Merge tool to get the
settings synchronized.

XHTML validation in Settings/User menu in ReqEdit.

The tool works in two modes:

• Direct Compare mode Users can automatically jump to the source of the compared
objects
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• Standalone mode

Compare ReqIF files

The easiest way to compare two documents is to use the Direct Compare mode, follow the
steps described below.

Open the two ReqIF files for comparison, select one of the documents,Click Add-ons >
Direct Compare

ReqEdit Add-ons, highlighted is the Direct
Compare tool

A question window will let the user choose the pair of the document for second file as NEW
or OLD, Press YES or No to configure the comparison members

ReqEdit Compare Add-on question popup

Compare overview window will show the compare statistics, then press Compare selected
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ReqEdit Compare Add-on overview window

A new window will let the user select additional attributes for quick comparison, and then
press OK

NOTE: main attributes are completely compared all the time, as the footer note displays

NOTE: the additional attributes are displayed in a single column as a text message
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ReqEdit Compare Add-on displaying additional attributes list to include in the comparison
result

Display logic for additional attributes:

• Html attributes will be compared as HTML but displayed as a text and limited to first
50 characters

• Strings will be limited to 50 first characters

• Dates will be converted to German date format

• Boolean values will be displayed as text

• Enumerations will be displayed as a string

Render Short Description

Will compare and display the ReqIF.Name attribute (in case of DNG export this will be a
copy of ReqIF.Text, and should be excluded from comparison for nicer overview)
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Display External ID

will show ReqIF.ForeignID attribute as a separate column

The Comparison Window

Displays the result of the comparison in a two sided window.

Right clicking any object the ReqIF.ID and External.ID (ReqIF.ForeignID) can be copied into
the clipboard

ReqEdit Comparison Add-on displaying the Comparison Window, with External ID and
additional attributes

Column description

ObjectNumber Hierarchical numbering by Headers similar to chapter structure,
optional # character shows text objects under the given chapter,
the background color suggests the type of change
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External ID Shows the contents of the ReqIF.ForeignID attribute
Main Column Displays the content of the objects with changes, green is the new content
(right side), red on is the removed or changed content (left side)
Other attributes Displays the concatenated additional attribute changes with green and
changed with red (on the left)
Status Displays the status description: new, changed, moved from source, moved and
changed, deleted (only left), referenced

Highlight colors

Structural changes

GREEN NEW
BLUE MOVED
ORANGE CHANGED, CHANGED & MOVED
RED DELETED
Referenced, is the source of the moved / changed objects

Content changes

GREEN New content
RED Removed content

Display unchanged rows

By default all content is displayed, to show only the changes uncheck the [Display un-
changed rows] checkbox at the top

Jump to source
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Jump to source by right-clicking an object in the comparison window, will select the object

in the source document

HTML Report

Users can save the result of the comparison as a HTML report. Pressing the Open results
in browser at the bottom will save the file and open the default browser.

ReqEdit Compare tool generated HTML report

The HTML report is a scripted web-page with couple functions:
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Highlighting objects/rows

Users clicking any row in the report will be highlighted and if possible, the pair will be
shown and also highlighted

Clicking the ObjectNumber or the row to jump to corresponding object pair. Highlighting is
similar to the comparison window.

Filter change type

The number of the different types of change are shown at the bottom of the page and can
be toggled to be visible or hidden

Show only changes

Show only the rows that are changed, moved, new or deleted, including the reference to
changes.
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Mark as read

Users can track the progress of the validation of the changes by marking each row as read
with the checkbox.

NOTE: this feature uses browser internal WebStorage mechanism, all markers are saved to
localStorage. All modern browsers have this feature but can be limited by security policies.

Show only unread

The button will toggle the display of only the rows which are not yet marked as read

Settings

Customize an additional logo and optional HTML content to include in the HTML report,
open the Administration > Settings menu.
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Compare Add-on settings window

NOTE: The logo image can only replaced with another one, there must always be a logo

Print to PDF

HTML report can be saved as PDF by printing the result to a PDF document within the
browser. To get a better viewing experience set the pdf size to A3 landscape or adjust the
print scaling and enable background colors.

Notices

In IE11 or other older browsers if "Mark as read" cannot be used it will be hidden. An
ActiveX script execution popup will ask to run the scripts inside the html report. Choose
Allow Blocked Content to enable the features.

Mark as read is saved inside the browser, moving the html report will not affect the read
markings.
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Tested on:

• Edge Version 91.0.864.41 (Official build) (64-bit)

• Chrome Version 91.0.4472.77 (Official Build) (64-bit)

Mark as read cannot be exported or transferred, its indented to be used only on one PC.

Standalone mode

Comparison between two unopened files in ReqEdit

Note: Opened files will be locked, other applications (ex: ReqEdit) will not be able to open
the files until closed
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ReqEdit compare add-on in standalone mode

Open the old ReqIF file on the left and the new on the right side and then press Compare in
the top menu.

Follow the wizard to configure comparison options, then press Compare selected documents
to display the result.

NOTE: Closing the file will release the exclusive lock and can be used by other applications

Compare limitations

• Compare works only on ReqIF files that can be opened in ReqEdit

• HTML element property changes will be ignored (class, id, style) except attachments
(object data tags)

• String and HTML attributes outside of the main column will be shortened the display
to 50 characters

• Sometimes if the content comparison is too complex will highlight more new changes
than necessary, but will never miss any change

• Opened files are exclusively locked until closed (no other app can open the files)
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Merge ReqIF files

Merge attributes one at a time from a ReqIF file to another ReqIF file. Can only be used in
standalone mode, meaning the files cannot be opened in other applications.

Open files on each side then select the attributes that needs to be merged and press Merge
menu item in the top menu. The merge options will be displayed.
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ReqEdit merge add-on displayin the options window and the merge details

Merge direction: left to right or right to left, depending on which side of the wizard window
are the new and old files

Force update: copies also the empty values from source

After the merge the attributes will be highlighted with green, repeat the merge process for
other attributes as well
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Save the merge results

Clicking the SAVE icon next to the file location will write the merged content into that file,
depending on the direction of the merge.

Data management

All files generated by the tool can be managed from the Administration menu.

Compare and Merge AddOn Administration menu

Open Logs – will show the daily logs folder

Open HTML reports – will show the folder of the comparison results

Cleanup HTML reports – will delete all the comparison results

Cleanup temp files – will delete all generated files

Merge Limitations
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• Only spec objects with the same ID can be merged

• Only the same type of attributes can be merged

• Opened files are exclusively locked until closed (no other app can open the files)

Logging

The application will produce a debug log containing all the performed actions Log is saved
in daily files.

Contents of log files

• Opening files

• Errors

– Attribute type mismatches

– No matches found

– No attributes selected

• Compare statistics

• Merge execution with details

– Updated values

– Skip merging causes
∗ identical values
∗ empty values
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2.5 July

Licence update without a licence manager installed (no ACC) (2022-07-18 10:57)

Use case:

License update in case of no license manager installed and more than one PC with ReqEdit
installed. The firm becomes the necessary .v2c files for license updating from REQTEAM,
conform the license IDs. Each .v2c file is for the PC with the same KeyID.

1. Find the KeyID info.

In File ReqEdit/LicenseActivation.exe.config change settings to ForceStart.

<setting name="ForceStart" serializeAs="String">
<value>True</value>
</setting>

Than click on Reqedit / LicenseActivation.exe
On the License info Tab you can find the Key ID of the certain PC

License activator - license info
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2. From the .v2c files that REQTEAM sent to you choose the one with the same KeyID
numbers.

3. Go to LicenseActivator and click on the button Activate.

Update license process through offline activation

Choose the .v2c file for that PC.

Click Open
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Successful license updating message.
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